
 

 

ΥΠΟΥΡΓΕΙΟ ΕΘΝΙΚΗΣ ΠΑΙΔΕΙΑΣ ΚΑΙ ΘΡΗΣΚΕΥΜΑΤΩΝ 
 
 
 
 
 
 
 
 
 
 

ADOBE FLASH CS3 
 
 

ΤΕΤΡΑΔΙΟ	ΜΑΘΗΤΗ	
	

 

 

 

 

 

 

 

 
 

ΠΑΡΑΓΩΓΗ 
 

 



 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Το παρόν εκπονήθηκε στο πλαίσιο

του Υποέργου 13 «Προσαρμογή Λογισμικού-Φάση ΙΙΙ» 

της Πράξης «Επαγγελματικό λογισμικό στην ΤΕΕ: επιμόρφωση και εφαρμογή» 

(Γ’ ΚΠΣ, ΕΠΕΑΕΚ, Μέτρο 2.3, Ενέργεια 2.3.2) 

 

που συγχρηματοδοτείται από την Ευρωπαϊκή Ένωση/Ευρωπαϊκό Κοινωνικό Ταμείο 

 

 



ΤΕΤΡΑΔΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 3 

 

ΠΕΡΙΕΧΟΜΕΝΑ 

 

1.  Εισαγωγή στη χρήση του Adobe® Flash® CS3 Professional .................................. 5 
Δραστηριότητα 1: Γνωριμία με το περιβάλλον του Adobe® Flash® CS3 
Professional ................................................................................................................ 5 
Δραστηριότητα 2: Σχεδιασμός και τροποποίηση απλών γραφικών ........................ 10 
Δραστηριότητα 3: Σχεδιασμός πιο σύνθετων γραφικών σε μονό layer................... 12 
Δραστηριότητα 4: Σχεδιασμός διαφανών αντικειμένων .......................................... 14 
Δραστηριότητα 5: Κατανόηση διάταξης και ομαδοποίησης αντικειμένων ............. 16 

2. Σύμβολα στο Flash και βασική κίνηση .................................................................... 18 
Δραστηριότητα 1:Δημιουργία γραφικών σε πολλαπλά layers ................................ 18 
Δραστηριότητα 2: Κατανόηση και οργάνωση των layers στο Macromedia Flash .. 19 
Δραστηριότητα 3: Δημιουργία και χρήση συμβόλων .............................................. 23 
Δραστηριότητα 4: Χρήση γραφικών που δεν δημιουργήθηκαν στο flash ............... 24 
Δραστηριότητα 5: Δημιουργία βασικών animation καρέ-καρέ ............................... 26 

3. Κίνηση και επεξεργασία σχήματος .......................................................................... 29 
Δραστηριότητα 1: Μετακίνηση, περιστροφή, αλλαγή κλίμακας γραφικών ............ 29 
Δραστηριότητα 2: Εφέ χρώματος στα γραφικά ....................................................... 31 
Δραστηριότητα 3: Δημιουργία κίνησης (animation) με motion tweening .............. 31 
Δραστηριότητα 4: Μετακίνηση αντικειμένων κατά μήκος συγκεκριμένης 
διαδρομής ................................................................................................................. 33 
Δραστηριότητα 5: Μεταμόρφωση αντικειμένων (Shape Tweening) ...................... 34 
Δραστηριότητα 6: Δημιουργία αντικειμένων που ταυτόχρονα μετακινούνται και 
μετασχηματίζονται ................................................................................................... 35 

4. Δημιουργία πιο σύνθετων animations στο Flash ..................................................... 37 
Δραστηριότητα 1: Κατανόηση σκηνών (scenes) ..................................................... 37 
Δραστηριότητα 2: Πολλαπλές κινήσεις ................................................................... 39 
Δραστηριότητα 3: Αντιστροφή καρέ ....................................................................... 42 
Δραστηριότητα 4: Δημιουργία κινούμενης μάσκας. ............................................... 43 
Δραστηριότητα 5: Εφαρμογή σε σύνθετα animations ............................................. 47 

5. Βασικές ενέργειες και χρήση των κουμπιών στο Flash ........................................... 49 
Δραστηριότητα 1: Κατανόηση του πάνελ «Actions» και των βασικών δυνατοτήτων 
του actionscripting ................................................................................................... 49 
Δραστηριότητα 2: Προσθήκη ενεργειών σε καρέ.................................................... 52 
Δραστηριότητα 3: Δημιουργία ετικετών σε καρέ .................................................... 54 
Δραστηριότητα 4: Δημιουργία βασικών κουμπιών ................................................. 54 
Δραστηριότητα 5: Δημιουργία slideshow ................................................................ 56 

6. Εξαγωγή των ταινιών του Flash............................................................................... 59 
Δραστηριότητα 1: Εξαγωγή ταινιών του Flash ....................................................... 59 
Δραστηριότητα 2: Έλεγχος τοποθέτησης και ενσωμάτωσης του αντικειμένου σε 
φυλλομετρητή (browser) .......................................................................................... 60 
Δραστηριότητα 3: Ρυθμίσεις του Flash Player ........................................................ 63 

7. Περισσότερα για τη χρήση των κουμπιών στο Flash .............................................. 65 
Δραστηριότητα 1: Ανάθεση ενεργειών σε κουμπιά ................................................ 65 
Δραστηριότητα 2: Κουμπιά με κίνηση (animated buttons) ..................................... 66 
Δραστηριότητα 3: Εισαγωγή δεδομένων με το πληκτρολόγιο ................................ 68 

8. Ήχοι στο Flash ......................................................................................................... 70 
Δραστηριότητα 1: Ηχητικοί τύποι  και εισαγωγή ήχων .......................................... 70 



ΤΕΤΡΑΔΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 4 

Δραστηριότητα 2: Ήχοι στα καρέ  και συγχρονισμός ήχου με animation .............. 72 
Δραστηριότητα 3: Ήχοι στα κουμπιά ...................................................................... 73 

9. Εργασία με βίντεο στο Flash ................................................................................... 75 
Δραστηριότητα 1: Εισαγωγή και εξαγωγή βίντεο στο Flash ................................... 75 
Δραστηριότητα 2: Προσομοίωση βίντεο στο Flash ................................................. 77 



ΤΕΤΡΑΔΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 5 

 

Φύλλο εργασίας 

 

1.  Εισαγωγή στη χρήση του Adobe® Flash® CS3 Professional 

 

Όνομα: 

Τάξη: 

Διάρκεια: 2 διδακτικές ώρες 

 

Διδακτικοί στόχοι: 

Με το συγκεκριμένο φύλλο εργασίας  θα:  

 

 γνωρίσετε το περιβάλλον εργασίας του Adobe Flash CS3  

 

 μάθετε να ανοίγετε και να κλείνετε το αρχείο ενός Flash project  

 

 μάθετε να σχεδιάζεται γραφικά πάνω στη σκηνή και να τα τροποποιείτε 

 

 μάθετε να κάνετε διάταξη των αντικειμένων 

 

 μάθετε να δημιουργείτε διαφανή αντικείμενα 

 

 

Δραστηριότητα 1: Γνωριμία με το περιβάλλον του Adobe® Flash® CS3 
Professional 

 
Βήμα 1ο: Δημιουργώντας ένα νέο project 

 

Ανοίγοντας την εφαρμογή του Flash, θα συναντήσετε την οθόνη καλωσορίσματος 

(Welcome screen), στην οποία υπάρχουν οι εξής κατηγορίες: 
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- Open a Recent Item 

- Create New 

- Create from Template 

 

 

Αυτά  είναι  συντομέυσεις  για 

γρηγορότερη  πρόσβαση  σε 

ορισμένες  επιλογές  που 

υπάρχουν  και  στο  Κεντρικό 

Μενού. 

 

 

 

 

 

 

Βήμα 2ο: 

Για να δημιουργήσετε μια νέα εφάρμογή, πηγαίνετε στο Μενού –«File» και επιλέξτε –«New». 

 

 

Βήμα 3ο: 

Στην καρτέλα που θα εμφανιστεί στα «General» επιλέγετε «Flash file(Actionscript 3.0) » ή «Flash 

file(Actionscript 2.0) », πατώντας αριστερό κλικ. 

 

 

To περιβάλλον του Adobe Flash CS3 

 

Στο  περιβάλλον  της  Flash  υπάρχει  μια  αυστηρή  δομή  για  την  δημιουργία  των  εφαρμογών,  η  οποία 

αποτελείται από τα εξής στοιχεία: 

 Τα Panel 
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 Τα Tools 

 Το Τimeline 

 Τα Layers 

 To Scene 

 

Κάνετε αντιστοίχηση των παρακάτω στοιχείων του πίνακα με τους αριθμούς που 

βλέπετε στην εικόνα του «timeline». 

 

 

 

 

Χρόνος αναπαραγωγής  

Μενού Timeline   

Αρθμοί καρέ  

Προβολή onion skin  

Τροποποίηση των ενδεικτικών onion  

Τρέχων καρέ  

Κεφαλή αναπαραγωγής  

Κεντρικό καρέ  

Επεξεργασία πολλαπλών καρέ  

Γραμμές κύλισης  

Προβολή onion skin outline  

Ρυθμός καρέ  
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Αντιστοιχίστε  τα παρακάτω στοιχεία του πίνακα με τους αριθμούς που βλέπετε στην 

εικόνα της εργαλειοθήκης του Flash. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εργαλείο shape  

Stroke Color   

Τμήμα Options   

Εργαλείο Hand   

Εργαλείο Paint Bucket   

Εργαλείο Arrow   

Εργαλείο Lasso  

Εργαλείο Pencil    

Εργαλείο Text  

Εργαλείο Subselect   

Εργαλείο Pen   

Εργαλείο Eyedropper   

Default Colors   



ΤΕΤΡΑΔΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 9 

Fill Color   

Swap color  

Εργαλείο Line   

Εργαλείο Brush   

Εργαλείο Free Transform  

Εργαλείο eraser  

Eργαλείο zoom  

Εργαλείο Ink Bottle   

 

 

Αναφέρετε τα βασικά πάνελ του Flash 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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Δραστηριότητα 2: Σχεδιασμός και τροποποίηση απλών γραφικών 

 

Για να σχεδιάσουμε και να τροποποιήσουμε απλά γραφικά με το Flash ακολουθούμε 

τα εξής βήματα: 

 

Βήμα 1: Επιλέγουμε το εργαλείο «Shape» από την 

εργαλειοθήκη και συγκεκριμένα το «Rectangle Tool» 

(συντόμευση με το πλήκτρο R). Για να επιλέξουμε άλλα 

σχήματα, απλά κάνουμε αριστερό κλικ στο κουμπί αυτό 

και στο μενού που εμφανίζεται επιλέγουμε το σχήμα που 

θέλουμε. 

 

 

 

 

 

 

Βήμα 2: Κρατώντας πατημένο το 

αριστερό πλήκτρο του ποντικιού δημιουργούμε στη σκηνή του flash ένα ορθογώνιο 

σχήμα και αφήνουμε το αριστερό πλήκτρο μόλις το σχήμα μας είναι όπως θέλουμε. 

 

Βήμα 3: Περιστρέφουμε το αντικείμενο χρησιμοποιώντας το «Free transform tool» 

που υπάρχει στην εργαλειοθήκη του Flash. Το συγκεκριμένο εργαλείο μας επιτρέπει 

να περιστρέψουμε αλλά και να κάνουμε μεγέθυνση – σμίκρυνση στο επιλεγμένο 

αντικείμενο. 
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Τι αντιπροσωπεύουν τα 8 σημεία λαβής (μαύρα τετραγωνάκια) που υπάρχουν στο 

περίγραμμα του σχήματός μας όταν επιλέγουμε «free transform» και τι 

αντιπροσωπεύει η άσπρη κουκκίδα στο κέντρο του σχήματος; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................  

Πως μπορούμε να φτιάξουμε έναν τέλειο κύκλο με τα εργαλεία του Flash; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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Δραστηριότητα 3: Σχεδιασμός πιο σύνθετων γραφικών σε μονό layer 

 

Τα παρακάτω βήματα περιγράφουν τη διαδικασία δημιουργίας πιο σύνθετων 

γραφικών με το Flash: 

 

Βήμα 1: Επιλέγουμε το εργαλείο «Shape» από την 

εργαλειοθήκη και συγκεκριμένα το «Rectangle Tool» 

(συντόμευση με το πλήκτρο R). Για να επιλέξουμε άλλα 

σχήματα απλά κάνουμε αριστερό κλικ στο κουμπί αυτό 

και στο μενού που εμφανίζεται επιλέγουμε το σχήμα που 

θέλουμε. 

 

 

 

 

 

 

Βήμα 2: Κρατώντας πατημένο το 

αριστερό πλήκτρο του ποντικιού δημιουργούμε στη σκηνή του Flash ένα ορθογώνιο 

σχήμα και αφήνουμε το αριστερό πλήκτρο μόλις το σχήμα μας είναι όπως θέλουμε. 

 

 

 

 

 

 

Βήμα 3: Με τον ίδιο ακριβώς τρόπο και 

διαλέγοντας και άλλα σχήματα («Polystar tool») 

δημιουργούμε το σχήμα της διπλανής εικόνας. 
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Βήμα 4: Για να αλλάξουμε το χρώμα 

του επιθυμητού αντικειμένου το 

επιλέγουμε με το ποντίκι και 

χρησιμοποιούμε τις επιλογές 

χρωμάτων («fill color» και «stroke 

color») στο παράθυρο των ιδιοτήτων 

στο κάτω μέρος της οθόνης για να 

δώσουμε το επιθυμητό χρώμα.  

 

 

 

 

 

Βήμα 5: Τελειοποιούμε το σχήμα μας 

φτιάχνοντας κύκλους με το εργαλείο «Shape» 

όπως κάναμε και στα βήματα 1-2. Αλλάζουμε 

τα χρώματά τους έτσι ώστε να εμφανιστεί το σχήμα της διπλανής εικόνας. 

 

Ποια η διαφορά του «STROKE COLOR» από  το «FILL COLOR»; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

......................................................................................................................................... 

Πως μπορούμε να φτιάξουμε το περίγραμμα ενός σχήματος με διακεκομμένες 

κουκίδες; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………….. 
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Τι αντιπροσωπεύει η ιδιότητα «ALPHA» στο χρώμα ενός σχήματος; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

 

Δραστηριότητα 4: Σχεδιασμός διαφανών αντικειμένων 

Για να σχεδιάσουμε διάφανα ή ημιδιάφανα γραφικά με το Flash ακολουθούμε τα εξής 

βήματα: 

 

Βήμα 1: Δημιουργούμε δύο σχήματα στη 

σκηνή του Flash π.χ. με το «Rectangle 

tool». Φροντίζουμε να επικαλύπτει το ένα 

το άλλο. Μπορούμε να τα μετακινήσουμε 

με το «Selection tool» όπου θέλουμε. 

 

 

 

 

 

Βήμα 2: Επιλέγουμε με το ποντίκι το σχήμα που 

είναι ορατό ολόκληρο σε εμάς και επιλέγουμε το 

εικονίδιο «Fill color» που βρίσκεται στο 

παράθυρο των ιδιοτήτων στο κάτω μέρος της 

οθόνης. Στην παλέτα χρώματος που θα 

εμφανιστεί επιλέγουμε κάποιο χρώμα π.χ. 

πράσινο.  
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Βήμα 3: Πηγαίνουμε πάλι στην παλέτα χρωμάτων και 

συγκεκριμένα στην επιλογή «Alpha» όπου και επιλέγουμε 

κάποια τιμή αδιαφάνειας (όσο μικρότερη η τιμή, τόσο πιο 

διαφανές το αντικείμενο). 

 

 

 

Βλέπουμε ότι το πράσινο τετράγωνο έχει γίνει 

διαφανές και πίσω του φαίνεται το μπλε τετράγωνο. 

Μπορούμε να πειραματιστούμε με διάφορες τιμές 

«Alpha» για να πετύχουμε το επιθυμητό αποτέλεσμα. 

 

 

 

Τι θα συμβεί αν δώσουμε τιμή 0 στο πεδίο «ALPHA»; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Μπορούμε να έχουμε πολλά ημιδιαφανή αντικείμενα το ένα πάνω από το άλλο; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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Δραστηριότητα 5: Κατανόηση διάταξης και ομαδοποίησης αντικειμένων 

 

 

 

Έχουμε τα εξής αντικείμενα πάνω στη σκηνή του Flash 

και παρατηρούμε ότι ο ήλιος πέφτει πάνω στο πολύγωνο 

ως διαφάνεια. 

 

 

 

 

 

Μπορούμε να μεταφέρουμε το 

πολύγωνο μπροστά από τον ήλιο, 

κάνοντας δεξί κλικ στο αντικείμενο 

και στις επιλογές «arrange» 

επιλέγουμε «send to back». 

 

 

 

 

Δοκιμάστε να παίξετε με τα αντικείμενα, πατώντας και τις υπόλοιπες επιλογές του  

«Arrange». Τι παρατηρείτε;  

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………................................................................
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Επιλέξτε το πάνελ με την καρτέλα «Align». Θα 

παρατηρήσετε ότι έχει αρκετές επιλογές, ανάλογα με 

την διάταξη που θέλουμε να κάνουμε στα αντικείμενα. 

 

 

 

 

 

 

Δοκιμάστε τις διάφορες επιλογές. Τι συμπέρασμα βγάζετε; Σχολιάστε τα 

αποτελέσματα. 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

......................................................................................................................................... 

..........................................................................................................................................  
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Φύλλο εργασίας  

2. Σύμβολα στο Flash και βασική κίνηση 

 

Όνομα: 

Τάξη: 

Διάρκεια: 2 διδακτικές ώρες 

Διδακτικοί στόχοι: 

Με το συγκεκριμένο φύλλο εργασίας  θα:  

 

 μάθετε να εργάζεστε σε πολλαπλά layers 

 

 κατανοήσετε τα layers και θα σχεδιάζετε γραφικά σε περισσότερα από ένα 

layer  

 

 γνωρίσετε τα σύμβολα και θα μπορείτε να τα δημιουργείτε 

 

 μάθετε να χρησιμοποιείτε γραφικά στο Flash, που έχουν δημιουργηθεί από 

άλλες εφαρμογές 

 

 μάθετε να δημιουργείτε animation 

 

Δραστηριότητα 1:Δημιουργία γραφικών σε πολλαπλά layers 

Ανοίγοντας το Flash παρατηρούμε ότι σαν 

default ρυθμίσεις, υπάρχει μόνο ένα layer στο 

σκηνικό. 

Για να δημιουργήσετε κι άλλα layers, μπορείτε 

να κάνετε το εξής:  

Πηγαίνετε πάνω στο Layer 1 και πατήστε δεξί 

κλικ. Στο μενού που εμφανίζεται επιλέξτε <<Insert Layer>>. Εναλλακτικά μπορείτε 

να κάνετε αριστερό κλικ στο εικονίδιο με την κενή σελίδα που βρίσκεται στο κάτω 

αριστερό μέρος της διπλανής εικόνας. 
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Μπορείτε με τον ίδιο τρόπο να δημιουργήσετε όσα layer θέλετε, ανάλογα με τις 

απαιτήσεις της εργασίας σας. 

 

Για να σχεδιάσετε γραφικά σε πολλαπλά Layers 

ακολουθείστε τα παρακάτω βήματα: 

Βήμα 1ο:  Επιλέξτε το Layer, στο οποίο θέλετε να 

σχεδιάσετε.  

Βήμα 2ο: Με την βοήθεια της εργαλειοθήκης 

σχεδιάστε τα γραφικά της αρεσκείας σας. 

Βήμα 3ο: Συνεχίστε την διαδικασία, επιλέγοντας κάθε φορά το επιθυμητό Layer. 

Να προσέχετε πάντα σε ποιο layer σχεδιάζετε, γιατί δουλεύοντας με πολλά layers, 

είναι πιθανό να μπερδευτείτε, με αποτέλεσμα να σχεδιάσετε σε διαφορετικό από το 

επιθυμητό layer. 

Αναφέρετε περιπτώσεις στην πραγματική ζωή, όπου χρησιμοποιούμε layers. 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Σε τι μας βοηθά η χρήση layers κατά τη γνώμη σας; Γιατί να μη βάλουμε όλα τα 

γραφικά σε ένα layer; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

 

 

Δραστηριότητα 2: Κατανόηση και οργάνωση των layers στο Macromedia Flash 

Όταν έχετε πολλά layers ταυτόχρονα στη σκηνή σας, καλό θα είναι να τα οργανώσετε 

σε φακέλους και δίνοντάς τους ονόματα.  
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Στα layers μπορείτε να δώσετε κάποιο όνομα για να 

ξέρετε τι περιέχουν. Απλά κάντε διπλό κλικ π.χ. στο 

layer 4 και δώστε κάποιο άλλο όνομα. Για παράδειγμα, 

αν ένα layer περιέχει ένα αυτοκινητάκι, τότε μπορείτε 

να του δώσετε το όνομα “car”. Έτσι, θα ξέρετε την επόμενη φορά σε ποιο layer 

βρίσκεται το αντικείμενό σας και θα το εντοπίσετε γρηγορότερα. Επίσης, σημαντική 

λεπτομέρεια είναι ότι με απλό κλικ πάνω στο όνομα του layer, αυτομάτως θα 

επιλεχθούν τα αντικείμενα που υπάρχουν μέσα σε αυτό. 

Μπορείτε  να αλλάξετε τη σειρά των layers, έτσι 

ώστε τα γραφικά που έχετε σχεδιάσει να 

τοποθετηθούν στο επιθυμητό βάθος. Για να το 

πετύχετε αυτό, κάντε drag ‘n’ drop το layer με 

το ποντίκι μας και το τοποθετείστε στη θέση 

που θέλετε. Όπως βλέπετε στη διπλανή εικόνα, 

τα γραφικά που βρίσκονται σε layers που είναι τοποθετημένα πιο ψηλά στη λίστα, 

εμφανίζονται πάνω από τα υπόλοιπα layers.  

 

Αν μετακινήσετε το layer “wheels” με το 

ποντίκι και το πάτε κάτω από το layer “car” 

θα δείτε ότι οι ρόδες του αυτοκινήτου θα 

πάνε πίσω από το αυτοκίνητο. 

 

 

Για να οργανώσετε τα layers σε φακέλους κάντε τα εξής: 

Βήμα 1ο: Έστω ότι έχετε τα 10 layers που φαίνονται στη 

διπλανή εικόνα. Αν και έχουν ονόματα, είναι δύσκολο να 

τα οργανώσετε έτσι π.χ. που ο δρόμος να πάει πίσω από τα 

υπόλοιπα μέρη του αυτοκινήτου.  

Θα χρησιμοποιήσετε την επιλογή <<Insert Layer Folder>> που 

βρίσκεται κάτω από τα layers και σας δίνει τη δυνατότητα να 

δημιουργήσετε έναν φάκελο.  
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Βήμα 2ο: Δώστε στο φάκελο ένα όνομα που περιγράφει 

τι αντικείμενα βρίσκονται μέσα σε αυτόν π.χ. 

<<καμπίνα αυτοκινήτου>>. 

 

Βήμα 3ο: Σύρατε με drag’n’drop τα layers 

<<τιμόνι>>, <<οδηγός>>, <<συνοδηγός>> μέσα στο 

φάκελο που δημιουργήσατε. Παρατηρείτε ότι τα 

layers που σύρατε 

έχουν μεταφερθεί 

λίγο πιο δεξιά στη λίστα. Έτσι, καταλαβαίνετε ότι 

βρίσκονται μέσα στον φάκελο. Αν θέλετε, κάντε κλικ στο βελάκι που βρίσκεται 

αριστερά από το φάκελο για να κρύψετε τα ονόματα των αντικειμένων που 

βρίσκονται στη λίστα.  

Βήμα 4ο: Ακολουθώντας πάλι τα βήματα 1-3 φτιάξτε και 

τους υπόλοιπους φακέλους που χρειάζεστε, έτσι ώστε να 

καταλήξετε  στη διπλανή εικόνα. 

 

 

Με το Flash σας δίνεται η δυνατότητα να κρύψετε από τη 

σκηνή τα layers που δε θέλετε και να κλειδώσετε όσα 

θέλετε για να μην τα μετακινήσετε κατά λάθος. 

Για να κρύψετε ένα layer: 

Κάντε κλικ στην μικρή κουκίδα 

που βρίσκεται κάτω από το 

εικονίδιο που συμβολίζεται με ένα 

μάτι, στο layer που θέλετε να 

κρύψετε. Δείτε ότι η κουκίδα 

αντικαθίσταται με ένα κόκκινο Χ 

και το layer εξαφανίζεται. 

Για να το εμφανίσετε κάντε το 

αντίστροφο – δηλαδή κλικ στο 

κόκκινο X και το layer 

εμφανίζεται πάλι στη σκηνή σας. 
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Αν έχετε πολλά layer και θέλετε να τα κρύψετε όλα, τι θα πατήσετε;  

.......................................................................................................................................... 

 

Για να κλειδώσετε ένα layer: 

Κάντε κλικ στην μικρή κουκίδα που βρίσκεται 

κάτω από το εικονίδιο που συμβολίζεται με 

ένα λουκέτο, στο layer που θέλετε να 

κλειδώσετε. Βλέπετε ότι η κουκίδα 

αντικαθίσταται με ένα μικρό λουκέτο. Στο layer αυτό τώρα δεν μπορείτε να κάνετε 

καμία διαδικασία (π.χ. να σχεδιάσετε ή να επιλέξετε ένα αντικείμενο) παρά μόνο να 

το διαγράψετε ή να το ξεκλειδώσετε πάλι. 

Για να το ξεκλειδώσετε τι θα κάνετε;  

..........................................................................................................................................

.......................................................................................................................................... 

 

Βάλτε στη σειρά τις λέξεις: σύννεφο, ουρανός, γη, ήλιος, πουλιά, από το χαμηλότερο 

στο υψηλότερο layer που θα πρέπει να μπουν έτσι ώστε να σχηματιστεί σωστά μια 

εικόνα χωρίς π.χ. ο ουρανός να υπερκαλύπτει τα πουλιά. 

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Ποια η διαφορά απόκρυψης και κλειδώματος των layers; Έχει νόημα ένα layer να 

είναι κρυμμένο και κλειδωμένο ταυτόχρονα; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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Δραστηριότητα 3: Δημιουργία και χρήση συμβόλων 

Τις περισσότερες φορές στο Flash χρειάζεται να αποθηκεύσετε κάποια αντικείμενα 

στη σκηνή για να έχετε εύκολη και γρήγορη πρόσβαση. Αυτό γίνεται με τη χρήση 

συμβόλων. 

Για να δημιουργήσετε ένα σύμβολο στο Flash ακολουθείστε τα παρακάτω βήματα:  

Βήμα 1ο: Επιλέξτε τα αντικείμενα που θέλετε να 

αποτελούν το σύμβολό σας. Στη συγκεκριμένη 

περίπτωση μετατρέψτε σε σύμβολο το αυτοκίνητο, 

έτσι ώστε να το χρησιμοποιήσετε πολλές φορές μέσα 

στη σκηνή σας. Το επιλέγετε κάνοντας κλικ στο 

layer στο οποίο βρίσκεται ή επιλέγοντας ένα ένα τα στοιχεία που το απαρτίζουν. 

Βήμα 2ο: Επιλέξτε από το μενού <<Modify>> / << 

Convert to 

Symbol>>. 

Εμφανίζεται ένα 

παράθυρο διαλόγου που σας προτρέπει να 

ονομάσετε το σύμβολο που θέλετε να δημιουργήσετε.  Ονομάστε το 

<<car_symbol>>, αφήστε τις άλλες παραμέτρους ως έχουν και πατήστε Οk. 

Βήμα 3ο: Το σύμβολο τώρα έχει εισαχθεί στη βιβλιοθήκη του 

flash και μπορείτε να το χρησιμοποιήσετε όσες φορές θέλετε 

απλά κάνοντάς το drag’n’drop μέσα στη σκηνή. Με τον 

τρόπο αυτό 

δημιουργούν

ται όσα 

στιγμιότυπα 

(instances) του αντικειμένου 

χρειάζεστε. Μεγάλο  πλεονέκτημα των συμβόλων είναι η εξοικονόμηση χώρου και η 

ευκολία αλλαγής ιδιοτήτων όλων των στιγμιότυπων, αλλάζοντας απλά μία φορά την 

ιδιότητα του συμβόλου. 

Για να αλλάξετε π.χ. το χρώμα σε όλα τα 

αυτοκίνητα κάντε 

διπλό κλικ στο 

σύμβολο που βρίσκεται στη βιβλιοθήκη και αλλάξτε 
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το μπλε χρώμα με κάποιο άλλο χρησιμοποιώντας την ιδιότητα fill color. Επιστρέψτε 

στη σκηνή για να δείτε το αποτέλεσμα με το βελάκι που έχει εμφανιστεί κάτω από το 

timeline. 

Βλέπετε ότι όλα τα αυτοκίνητα στη σκηνή σας 

άλλαξαν στο χρώμα που επιλέξατε χωρίς να 

μπείτε ξεχωριστά μέσα στο καθένα.  

 

Αναφέρετε 3 πλεονεκτήματα της χρήσης συμβόλων. 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Ποιος είναι ο μικρότερος αριθμός συμβόλων 

που μπορεί να χρησιμοποιηθεί για να 

εμφανιστεί η διπλανή εικόνα; 

 

 

 

………………………………………………

………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………… 

 

 

 

Δραστηριότητα 4: Χρήση γραφικών που δεν δημιουργήθηκαν στο flash 

Για να εισάγετε στο Flash γραφικά που κατασκευάστηκαν με κάποιο άλλο 

πρόγραμμα επεξεργασίας εικόνας ακολουθείστε τα εξής βήματα: 
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Βήμα 1ο: Ενεργοποιείστε ένα layer κάνοντας 

κλικ πάνω στο όνομά του.  

 

Βήμα 2ο: Επιλέξτε «File/Import/Import to 

Stage» ή «File/Import/Import to Library» 

αντίστοιχα αν θέλετε το γραφικό να 

εμφανιστεί απευθείας στη σκηνή ή στη 

βιβλιοθήκη του Flash. Στο συγκεκριμένο 

παράδειγμα επιλέξτε «Import to Stage». 

Στο ακόλουθο παράθυρο διαλόγου επιλέξτε το αρχείο που περιέχει το γραφικό που 

θέλετε να εισάγετε και πατήστε <<Οpen>>. 

Βήμα 3ο:  

Το γραφικό σας εισάγεται στο flash 

και μπορείτε τώρα να το 

μετατρέψετε σε σύμβολο ή να 

κάνετε όποια άλλη επεξεργασία 

χρειάζεστε (μεγέθυνση, σμίκρυνση 

κ.α.). 
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Έστω ότι έχετε εισάγει στο flash ένα γραφικό και το έχετε μετατρέψει σε σύμβολο. Τι 

θα γίνει αν σβήσετε το γραφικό από τη σκηνή και τι αν σβήσουμε το γραφικό από τη 

βιβλιοθήκη; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Μπορείτε με τη χρήση του «Fill Color» και «Stroke Color» να αλλάξετε το χρώμα 

ενός γραφικού που έχετε εισάγει στη σκηνή σας; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

 

 

Δραστηριότητα 5: Δημιουργία βασικών animation καρέ-καρέ 

Για να δημιουργήσετε ένα βασικό animation με τη χρήση frames ακολουθείστε τα 

εξής βήματα: 

Βήμα 1ο: Δημιουργείστε ένα σχήμα από την 

εργαλειοθήκη του Flash. Στο παράδειγμα έχει 

φτιαχτεί ένας κύκλος. Αυτός αυτόματα 

τοποθετείται στο πρώτο frame του timeline της 

σκηνής μας. Δώστε ένα χρώμα στο 

αντικείμενο. 
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Βήμα 2ο: Τοποθετήστε το ποντίκι στο frame που βρίσκεται ο 

κύκλος που φτιάξατε και πατήστε δεξί κλικ. Στο μενού που 

εμφανίζεται επιλέξτε <<Copy frames>>. Με την επιλογή 

αυτή, ό,τι περιέχει το συγκεκριμένο frame (στην περίπτωση 

αυτή ο κύκλος) αποθηκεύεται στη μνήμη.  

 

 

Βήμα 3ο: Πηγαίνετε στο αμέσως επόμενο frame (frame 2) 

του timeline και κάντε δεξί κλικ και <<Paste frames>>. Ο 

κύκλος του προηγούμενου frame αντιγράφεται αυτόματα σε 

αυτό το frame και στην ίδια ακριβώς θέση. 

Βήμα 4ο: Επιλέξτε με το 

ποντίκι τον κύκλο που 

βρίσκεται στο δεύτερο frame και μετατοπίστε τον λίγο 

πιο δεξιά με τα βελάκια του πληκτρολογίου. Τώρα 

έχουμε 2 frame ενός animation. 

 

Βήμα 5ο: Επαναλάβετε τα βήματα 2-4, επιλέγοντας 

κάθε φορά το τελευταίο frame που έχετε φτιάξει, 

έτσι ώστε να κατασκευάσετε 5 καρέ 

διαδοχικής κίνησης του κύκλου σας. 

 

Για να αναπαράγετε καρέ-καρέ την κίνηση του 

κύκλου πατήστε <<Enter>> ή επιλέξτε 

«Control/Play» από το μενού του Flash.  
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Πως μπορείτε να δημιουργήσετε animation με πολλά αντικείμενα ταυτόχρονα (π.χ. 

ένα κύκλο, ένα τετράγωνο και ένα αστέρι που μετακινούνται σε τυχαίες και 

διαφορετικές κατευθύνσεις το καθένα); 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Τι θα συμβεί αν αλλάξετε τον ρυθμό καρέ, από 12 που είναι προεπιλεγμένο σε 24; 

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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Φύλλο εργασίας  

3. Κίνηση και επεξεργασία σχήματος  

 

Όνομα: 

Τάξη: 

Διάρκεια: 3 διδακτικές ώρες 

 

 

Διδακτικοί στόχοι: 

Με το συγκεκριμένο φύλλο εργασίας  θα μάθετε:  

 

 να μετακινείτε, να περιστρέφετε και να αλλάζετε την κλίμακά  των 

γραφικών σας 

 να εφαρμόζετε χρωματικά εφέ στα γραφικά  

 να δημιουργείτε κίνηση (animation) με motion tweening  

 να μετακινείτε αντικείμενα κατά μήκος συγκεκριμένης διαδρομής  

 να μετασχηματίζετε αντικείμενα  (shape tweening) 

 να δημιουργείτε αντικείμενα που ταυτόχρονα μετακινούνται και 

μετασχηματίζονται 

 

 

Δραστηριότητα 1: Μετακίνηση, περιστροφή, αλλαγή κλίμακας γραφικών   

 

Βήμα 1ο.  Ζωγραφίστε ένα ορθογώνιο. 

Βήμα 2ο. Θα μπορούσατε να κάντε όλα τα επόμενα βήματα της παρούσας 

δραστηριότητας χωρίς να το μετατρέψετε σε σύμβολο. Αλλά επειδή σε αυτό το φύλλο 

εργασίας πρόκειται να μάθετε motion tweening, το οποίο εφαρμόζεται στα 

στιγμιότυπα συμβόλων, μετατρέψτε το ορθογώνιο αυτό σε σύμβολο. Δώστε του 

όνομα Orthogonio. Τώρα στη σκηνή σας πρέπει να έχετε ένα στιγμιότυπο του 

συμβόλου αυτού. Επιλέξτε  το.  

Βήμα 3ο.  Αλλάξτε την τοποθεσία του είτε σέρνοντάς το με το ποντίκι, είτε 

χρησιμοποιώντας βελάκια (arrow keys), είτε με το «Property inspector» εισάγοντας 
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τις τιμές για το x και το y, είτε με το «Info panel».  

Βήμα 4ο.  Για να περιστρέψετε το ορθογώνιο επιλέξτε  το εργαλείο «Free 

Transform». Τοποθετήστε τον δείκτη του ποντικιού λίγο έξω από την γωνιακή λαβή 

και σύρτε την. 

 

Βήμα 5ο.  Για την αλλαγή της κλίμακας σέρνετε τη λαβή στο πλάι ή τη γωνιακή λαβή 

τοποθετώντας τον δείκτη του ποντικιού πάνω τους. 

 

 

 

Δοκιμάστε να περιστρέψετε το ορθογώνιο και να αλλάξετε την κλίμακά του και με 

τον παρακάτω τρόπο: ανοίξτε το μενού «Modify > Transform», επιλέξτε «Scale and 

rotate» και εισάγετε αντίστοιχες τιμές. 

Αν εισάγετε έναν αρνητικό αριθμό στο «Rotate» του παραθύρου «Scale and rotate», 

σε ποια κατεύθυνση θα περιστραφεί το ορθογώνιο;   

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

......................................................................................................................................... 
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Δραστηριότητα 2: Εφέ χρώματος στα γραφικά  

 

Κάθε στιγμιότυπο (instance) ενός συμβόλου μπορεί  να έχει δικό του χρωματικό εφέ, 

το οποίο ορίζεται στο «Property inspector». 

Βήμα 1ο.  Επιλέξτε  το  στιγμιότυπο του συμβόλου του ορθογωνίου από την 

προηγούμενη δραστηριότητα και, αν δεν βλέπετε το «Property inspector», επιλέξτε 

«Window > Properties > Properties».  

Βήμα 2ο. Από το μενού «Color» του «Property inspector» μπορείτε να επιλέξετε μια 

από τις επιλογές (Brightness, Tint, Alpha, Advanced), την οποία μπορείτε να 

ρυθμίσετε. Εδώ επιλέξτε «Tint». 

Βήμα 3ο. Όταν επιλέγετε «Tint», εμφανίζεται δίπλα η δυνατότητα επιλογής 

χρώματος. Επιλέξτε κάποιο άλλο χρώμα για το συγκεκριμένο στιγμιότυπο (αυτή η 

επιλογή δεν επηρεάζει το χρώμα του ίδιου του συμβόλου).  

 

 

Πώς μπορείτε να αλλάξετε το χρώμα του ίδιου του συμβόλου; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Δοκιμάστε να εφαρμόσετε χρωματικό εφέ στο στιγμιότυπο του συμβόλου του 

ορθογωνίου επιλέγοντας «Brightness» και «Alpha» από το μενού «Color» του 

«Property inspector».  

 

Δραστηριότητα 3: Δημιουργία κίνησης (animation) με motion tweening  

Στην εφαρμογή Flash υπάρχει δυνατότητα δημιουργίας  tweening δύο ειδών: 
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 motion tweening – όταν αλλάζουν οι ιδιότητες αντικειμένου με χρόνο, όπως 

θέση, μέγεθος, γωνία περιστροφής, χρώμα κτλ., τις οποίες μάθατε να 

αλλάζετε στις προηγούμενες δραστηριότητες του παρόντος φύλλου 

 shape tweening - όταν αλλάζει το σχήμα αντικειμένου με χρόνο 

Σ’ αυτή τη δραστηριότητα θ’ ασχοληθείτε με το πρώτο είδος του tweening - motion 

tweening.  

Πρέπει να ορίσετε τις ιδιότητες ενός αντικειμένου σε ένα αρχικό καρέ-κλειδί 

(keyframe) και ύστερα να τις αλλάξετε στο επόμενο καρέ-κλειδί. Το Flash θα 

δημιουργήσει μόνο του την κίνηση για όλα τα ενδιάμεσα καρέ. 

Βήμα 1ο.  Στο προηγούμενο φύλλο εργασίας μάθατε να δημιουργείτε σύμβολα. Με 

τον δείκτη τρέχοντος καρέ στο καρέ 1 της χρονογραμμής (Timeline) ζωγραφίστε ένα 

ορθογώνιο και μετατρέψτε το σε σύμβολο. Στη σκηνή τώρα θα βρίσκεται ένα 

στιγμιότυπό του συμβόλου αυτού (θα μπορούσε να χρησιμοποιηθεί ένα έτοιμο 

σύμβολο από τη βιβλιοθήκη. Σε αυτή την περίπτωση θα το σέρνατε από τη 

βιβλιοθήκη στο σκηνικό (Stage) με το ποντίκι). Τοποθετήστε το στην αριστερή 

πλευρά του σκηνικού - εκεί που θέλετε να εμφανίζεται όταν ξεκινά η κίνησή του. 

Βήμα 2ο: Επιλέξτε καρέ 30 στη χρονογραμμή (Timeline) και μετατρέψτε το σε καρέ-

κλειδί πατώντας F6 ή επιλέξτε «Insert > Timeline > Keyframe». Με τον δείκτη 

τρέχοντος καρέ στο καρέ 30, μετακινήστε το στιγμιότυπο του συμβόλου, 

περιστρέψετε το, αλλάξετε την κλίμακά του και να εφαρμόστε σε αυτό χρωματικό 

εφέ.  

Βήμα 3ο: Επιλέξτε οποιοδήποτε καρέ ανάμεσα στο 1 και 30.  

Βήμα 4ο: Κάντε δεξί κλικ σ’ αυτό το καρέ και επιλέξτε Create Motion Tween. Για να 

ορίσετε διάφορες παραμέτρους του motion tweening, μπορείτε να επιλέξτε «Motion» 

από την αναδιπλούμενη λίστα (pop-up μενού) «Tween» στο «Property inspector». 

Εάν αλλάξατε το μέγεθος του στιγμιότυπου, πρέπει να είναι επιλεγμένο το «Scale» 

στο «Property inspector».  

Βήμα 5ο. Για να δείτε τι δημιουργήσατε, κάντε κλικ στο πρώτο καρέ της 

χρονογραμμής (Timeline) και πατήστε το Enter ή επιλέξτε «Control > Test Movie». 

Σημείωση: Κατά τη δημιουργία του motion tweening πρέπει να έχετε μόνο ένα 

αντικείμενο στο αντίστοιχο layer. 

Με πόσους τρόπους μπορούμε να δημιουργήσουμε ένα «motion tweening»; 



ΤΕΤΡΑΔΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 33 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

 

 

Δραστηριότητα 4: Μετακίνηση αντικειμένων κατά μήκος συγκεκριμένης 
διαδρομής  

 

Μέχρι τώρα στο motion tweening ορίζαμε την αρχική και την τελική θέση του 

αντικειμένου. Η εφαρμογή Flash δημιουργούσε την κίνηση για όλα τα ενδιάμεσα 

καρέ, δημιουργώντας μια γραμμική μεταβολή μεταξύ της αρχικής και της τελικής 

κατάστασης. Όμως μπορεί να ορίζεται διαφορετική διαδρομή αντί για την ευθεία που 

προκύπτει από τη γραμμική μεταβολή για τις μεταβολές της θέσης του αντικειμένου. 

Ακολουθήστε τα παρακάτω βήματα για να το υλοποιήσετε: 

Βήμα 1ο.  Επιλέξτε  το layer, το οποίο περιέχει το motion-tweened animation και 

επιλέξτε  «Insert  > Timeline > Motion Guide».  

Βήμα 2ο. Έτσι, δημιουργείται καινούργιο layer πάνω από το επιλεγμένο, το οποίο 

έχει όνομα «Guide:» και το όνομα του layer που πάνω του βρίσκεται το στιγμιότυπο.  

Βήμα 3ο. Ζωγραφίστε την επιθυμητή διαδρομή σ’ αυτό το layer χρησιμοποιώντας το 

μολύβι της εργαλειοθήκης.  

 

 

Βήμα 4ο. Στο καρέ 1 ευθυγραμμίστε το κέντρο του κινούμενου αντικειμένου  με την 

αρχή της γραμμής διαδρομής και στο τελευταίο καρέ ευθυγραμμίστε το κέντρο του 
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κινούμενου αντικειμένου  με το τέλος της γραμμής. 

Βήμα 5ο. Για να δείτε τι δημιουργήσατε «τρέξτε» την εφαρμογή σας πατώντας 

control και enter . 

Ποια είναι κατά την γνώμη σας τα πλεονεκτήματα ενός «guide layer»; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Δραστηριότητα 5: Μεταμόρφωση αντικειμένων (Shape Tweening) 

 

Σ’ αυτή τη δραστηριότητα θ’ ασχοληθείτε με το δεύτερο είδος του tweening (shape 

tweening), το οποίο μετασχηματίζει ένα σχήμα σε ένα άλλο. Εσείς σχεδιάζετε 

σχήματα σε δύο καρέ-κλειδιά και η εφαρμογή Flash παράγει τα ενδιάμεσα καρέ. 

 

Βήμα 1ο:  Σε ένα νέο αρχείο σχεδιάστε έναν κύκλο στη σκηνή. Μην το μετατρέψετε 

σε σύμβολο.  

 

 

Βήμα 2ο: Επιλέξτε το καρέ 30 στη χρονογραμμή (Timeline) και μετατρέψτε το σε 

καρέ- κλειδί πατώντας F6 ή επιλέξτε «Insert > Timeline > Keyframe». Αυτό το καρέ  

θα είναι ίδιο με το πρώτο καρέ. 

Βήμα 3ο: Επιλέξτε το καρέ 15 στη χρονογραμμή (Timeline) και μετατρέψτε και αυτό 

το καρέ σε καρέ-κλειδί πατώντας F6 ή επιλέξτε «Insert > Timeline > Keyframe».  

Βήμα 4ο: Με τον δείκτη τρέχοντος καρέ στο καρέ 15 κάντε μία μικρή αλλαγή στον 
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κύκλο ως εξής: με το εργαλείο επιλογής κάντε κλικ κάπου έξω από τον κύκλο και 

τοποθετήστε το δείκτη κοντά στην περιφέρεια του κύκλου, μέχρι να εμφανίσει ένα 

τόξο κάτω από το βέλος. Κάντε κλικ και σύρτε το λίγο προς το κέντρο του κύκλου. 

Θα επιτύχετε κάτι παρόμοιο με αυτό της παρακάτω εικόνας. 

 

 

Βήμα 5ο: Κάντε κλικ στο καρέ 1, κρατήστε πατημένο το πλήκτρο Shift και κατόπιν 

κάντε κλικ στο καρέ 15. Επιλέξτε «Shape» από την αναδιπλούμενη λίστα (pop-up 

μενού) Tween στο «Property inspector».  

Βήμα 6ο. Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie».  

 

 

Δραστηριότητα 6: Δημιουργία αντικειμένων που ταυτόχρονα μετακινούνται και 
μετασχηματίζονται 

 

Σε απλές περιπτώσεις θα μπορούσατε μέσα στο shape tweening όχι μόνο να 

μετασχηματίζετε τα γραφικά, αλλά και να τα μετακινείτε· σε πιο περίπλοκες 

περιπτώσεις θα χρειαστεί να συνδυάσετε το «motion tweening» με το «shape 

tweening». Γι αυτό θα δημιουργήσετε ένα Movie Clip με «shape tweening» μέσα του 

και ύστερα θα χρησιμοποιήσετε αυτό ως σύμβολο δημιουργώντας «motion 

tweening». 

Βήμα 1ο.  Σε ένα νέο αρχείο επιλέξτε  «Insert  > New Symbol», δώστε του όνομα 

“mcShapeTween” και σημειώστε επιλογή «Movie Clip». Μέσα σ’ αυτό το Movie 

Clip δημιουργείστε «shape tweening», όπως το μάθατε στη Δραστηριότητα 5 του 

παρόντος φύλλου εργασίας. 

Βήμα 2ο. Επιστρέψετε στην αρχική σκηνή [για να το κάνετε πατήστε την επιλογή  

Scene 1 που βρίσκεται κάτω από τη χρονογραμμή (Timeline) ]. 

 Βήμα 3ο. Σύρτε με το ποντίκι το Movie Clip  “mcShapeTween”  από τη βιβλιοθήκη 

στο σκηνικό. Δημιουργήστε «motion tweening», όπως το μάθατε στη Δραστηριότητα 

3 του παρόντος φύλλου εργασίας χρησιμοποιώντας το «Movie Clip»  
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“mcShapeTween” . 

Βήμα 4ο. Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». 

 

Δοκιμάστε να δημιουργήσετε «shape tweening» όπως στη Δραστηριότητα 5 με τη 

διαφορά ότι στο Βήμα 4ο: όχι μόνο να μετασχηματίσετε, αλλά και να μετακινήσετε 

τον κύκλο. 
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Φύλλο εργασίας  

4. Δημιουργία πιο σύνθετων animations στο Flash 

 

Όνομα: 

Τάξη: 

Διάρκεια: 3 διδακτικές ώρες 

 

Διδακτικοί στόχοι: 

Με το συγκεκριμένο φύλλο εργασίας  θα:  

 κατανοήσετε τις σκηνές (scenes) 

 

  μάθετε να κάνετε animation με πολλαπλές κινήσεις 

 

  μάθετε να κάνετε αντιστροφή των καρέ 

 

 μάθετε να δημιουργείτε κινούμενη μάσκα 

 

 μάθετε να δημιουργείτε σύνθετα animations 

 

 

Δραστηριότητα 1: Κατανόηση σκηνών (scenes) 

 

Στο περιβάλλον του Adobe Flash CS3, μπορείτε να 

χρησιμοποιήσετε περισσότερες από μία σκηνές, 

ανάλογα με τις απαιτήσεις του project που 

σχεδιάζετε.  

Για να δείτε πόσες σκηνές υπάρχουν  στην εργασία 

σας, καθώς και να τις διαχειριστείτε, ανοίξτε το  

Scene panel (πάνελ σκηνής). 

Βήμα 1ο  Ανοίγετε το μενού «Window» από το 

«MenuBar» του Flash 

Βήμα 2ο Επιλέξτε από τα «other panels»  το «scene» 
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Θα δείτε ότι εμφανίζεται το πάνελ των σκηνών, όπως 

φαίνεται στη διπλανή εικόνα. Από δω μπορείτε να 

διαχειριστείτε τις σκηνές σας, δηλαδή να προσθέσετε νέα 

σκηνή, να δημιουργήσετε αντίγραφο μιας υπάρχουσας ή 

και να διαγράψετε μια σκηνή. 

 

 Για να προσθέσετε νέα σκηνή στο  project σας πατήστε το εικονίδιο                          

Τι παρατηρείτε;  

....................................................................................................................................

.................................................................................................................................... 

 Για να δημιουργήσετε ένα αντίγραφο μιας σκηνής, επιλέξτε πρώτα την σκηνή που 

θέλετε και στη συνέχεια πατήστε  Τι παρατηρείτε; 

....................................................................................................................................

.................................................................................................................................... 

 Για να διαγράψετε μια σκηνή, επιλέξτε την πρώτα και στην συνέχεια πατήστε το 

εικονίδιο      

 Για να κάνετε μετονομασία σε μια σκηνή, πατήστε αριστερό διπλό κλικ πάνω στο 

όνομα της σκηνής. 

 Μπορείτε να αλλάξετε την σειρά των σκηνών στο πάνελ, με την μέθοδο «drag ’n’ 

drop». Δημιουργείστε μια 2η σκηνή και σύρτε την προς τα πάνω. Τότε η 1η σκηνή  

θα μετατοπιστεί στην 2η θέση. 

 

 

 

Δοκιμάστε να διαγράψετε όλες τις σκηνές από το πανελ. Τι παρατηρείτε; 

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Κάντε μετονομασία 2 σκηνών, και βάλτε το ίδιο όνομα και στις 2. Τι παρατηρείτε; 
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…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

Σε τι εξυπηρετεί η ύπαρξη η χρήση πολλών σκηνών έναντι μίας;  

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 

 

Δραστηριότητα 2: Πολλαπλές κινήσεις 

Σε ένα animation μπορείτε να βάλετε σύνθετες και πολλαπλές κινήσεις. 

Για να δημιουργήσετε ένα animation που θα κάνει πολλαπλές κινήσεις πάνω στην 

σκηνή ακολουθήστε τα παρακάτω βήματα: 

 

Βήμα 1ο :Δημιουργείστε ένα αντικείμενο της αρεσκείας 

σας, π.χ έναν χρωματιστό κύκλο με το «oval tool» και 

μετατρέψτε το σε σύμβολο. Τοποθετήστε το στην πάνω 

αριστερή  γωνία της σκηνής. 
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Βήμα 2ο :Πηγαίνετε στο frame 25 και κάντε το «keyframe».  

 

 

 

 

Βήμα 3ο: Έχοντας επιλέγμένο το frame 25, μετατοπίστε 

τον κύκλο στην κάτω δεξιά γωνία της σκηνής,ώστε 

να δημιουργηθεί το animation. 

Βήμα 4ο:Επιλέξτε το frame 50 και κάντε το «keyframe» και στην συνέχεια 

μετατοπίστε τον κύκλο στην κάτω αριστερή γωνία της σκηνής. 

Βήμα 5ο:Ακολουθείστε την ίδια διαδικασία, δημιουργόντας «keyframe» και στο 

frame 70, μετατοπίζοντας τον κύκλο στην δεξιά πάνω γωνία της σκηνής. 

 

 

«frame 1»            «frame 25»   «frame 50»             «frame  70»  

 

Βήμα 6ο: Δημιουργείστε τις ενδιάμεσες 

κινήσεις του κύκλου με την επιλογή «Create 

Motion Tween»: 

 Πατήστε δεξί κλικ πάνω σε οποιοδήποτε frame ανάμεσα στο 1 και στο 

25 και στη συνέχεια την επιλογή «Create Motion Tween». 

 Πατήστε δεξί κλικ πάνω σε οποιοδήποτε frame ανάμεσα στο 25 και 

στο 50 και ύστερα την επιλογή  «Create Motion Tween». 

 Πατήστε δεξί κλικ πάνω σε οποιοδήποτε frame ανάμεσα στο 50 και 

στο 70 και ακολούθως την επιλογή «Create Motion Tween». 
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Παρατηρήστε ότι στην μπάρα του του Timeline ύπαρχουν τα βελάκια ανάμεσα στα 

keyframes, που  δείχνουν οτι έχουν δημιουργηθεί τα ενδίαμεσα καρέ (frames) του 

animation. 

Βήμα 8ο: Επιλέξτε το 1ο frame απο το Timeline, ώστε να γυρίσει το animation στην 

αρχή και πατήστε «ΕΝΤΕR» 

Tί παρατηρείτε; 

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Ποιος ο ρόλος των ενδιάμεσων keyframes (25,50) μέσα στην χρονογραμμή;  

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

…………………………………………………………………………………………

………………………………………………………………………………………… 
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Δραστηριότητα 3: Αντιστροφή καρέ 

Σε ένα animation μπορείτε να αντιστρέψετε τα καρέ του (frames), με αποτέλεσμα να 

αναπαράγεται αντίστροφα, δηλαδή από το τελευταίο μέχρι το πρώτο. 

Βήμα 1ο :Δημιουργείστε ένα animation με τον τρόπο που έχετε διδαχθεί. Για 

παράδειγμα μια κόκκινη σφαίρα, όπου θα μετακινείτε από την αριστερή πάνω γωνία 

της σκηνής, στης κάτω δεξιά γωνία μέσα σε 25 frames. 

 

 

 

 

 

 

Βήμα 2o : Πηγαίνετε στη χρονογραμμή (Timeline) 

και  επιλέξτε όλα τα frames του animation. 

 

Βήμα 3ο : Πατήστε δεξί κλικ και στις επιλογές                 

που εμφανίζονται, επιλέξτε την εντολή «reverse 

frames» 

Τώρα μπορείτε να τρέξετε το animation, 

πατώντας «ΕNTER» 

 Τι παρατηρείτε; 

 Ποια η διαφορά με το πρώτο animation; 

 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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Δραστηριότητα 4: Δημιουργία κινούμενης μάσκας. 

 

Βήμα 1ο : Επιλέξτε από την εργαλειοθήκη το «text tool» 

Βήμα 1ο : Στις ιδιότητες («properties» panel) επιλέξτε την γραμματοσειρά «Times 

New Roman», μέγεθος γραμματοσειράς (font size) 80,χρώμα μαύρο. Επίσης επιλέξτε  

την «έντονη 

γραφή» 

(Bold) πατώντας το κουμπάκι «B» 

 

Βήμα 3ο: Πηγαίνετε το ποντίκι στο κέντρο και 

αριστερά της σκηνής, πατήστε αριστερό κλικ για να 

ενεργοποιήσετε το «text tool» και γράψτε το όνομά 

σας.  

Τώρα θα μάθετε να δημιουργείτε  ένα layer μάσκας, 

για να το χρησιμοποιείται στα σχέδιά σας. 

Βήμα 4ο: Πατήστε δεξί κλικ πάνω στο layer 1 και επιλέξτε «Insert layer». 

 

 

 

 

Βήμα 5ο : Αφού ελέγξετε ότι έχετε επιλεγμένο το layer 2 

(καθώς θα εργαστείτε), πηγαίνετε στην εργαλειοθήκη και επιλέξτε το «oval tool» που 

βρίσκεται μέσα στο «shape tool». 

Βήμα 6ο : Πηγαίνετε στην σκηνή και σχεδιάστε έναν 

τέλειο κύκλο, με την χρήση του πλήκτρου «SHIFT», με 

μέγεθος λίγο μεγαλύτερο από ένα χαρακτήρα. Έπειτα, με 

την μέθοδο drag ’n’ drop, σύρτε προσεχτικά τον κύκλο 

πάνω στο πρώτο γράμμα, ώσπου να το καλύψετε. 

Βήμα 7ο: Πατήστε δεξί κλικ πάνω στο layer 2 και 

ενεργοποιήστε 

την επιλογή «Mask» 
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Τι παρατηρείται τώρα στην σκηνή; Γιατί εξαφανίστηκαν τα υπόλοιπα γράμματα από 

το όνομά σας; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Τι θα συνέβαινε αν στο layer 1 είχατε τοποθετήσει μια φωτογραφία; Τι θα 

εμφανίζονταν πάνω στην σκηνή; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Τι θα συνέβαινε αν είχατε σχεδιάσει έναν κύκλο πολύ μεγαλύτερο και τον 

τοποθετούσατε πάνω στα γράμματα; Θα είχαμε το ίδιο αποτέλεσμα πάνω στην 

σκηνή; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

Μπορείτε να κάνετε την μάσκα να κινείτε πάνω στην σκηνή, με τον ίδιο τρόπο που 

φτιάχνετε animation, εμφανίζοντας έτσι μόνο ότι υπάρχει κάτω από αυτήν, κατά το 

πέρασμα της . 

Βήμα 8ο: Πατήστε πάλι δεξί κλικ στο layer 2 και απενεργοποιήστε την επιλογή 

«Mask», για να μπορείτε να βλέπετε την σκηνή και να μπορείτε να εργαστείτε. 

Βήμα 9ο : Επειδή με την δημιουργία μάσκας κλειδώνουν 

αυτόματα τα layers, κάντε κλικ  πάνω στο εικονίδιο του 
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λουκέτου, για να την απενεργοποιήσετε και να μπορείτε να επεξεργαστείτε τα 

γραφικά σας. 

Βήμα 10ο : Έχοντας επιλεγμένο το layer 1, πατήστε δεξί κλικ πάνω στο καρέ (frame) 

50 και εισάγετε «keyframe». 
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Βήμα 11ο :Επιλέξτε τώρα το layer 2 και εισάγεται και σ’ αυτό «keyframe» στο frame 

50. Μετατοπίστε τον κύκλο πάνω στο τελευταίο γράμμα του ονόματος σας, αφού 

πρώτα προσέξετε ότι είναι επιλεγμένο το frame 50 και όχι κάποιο άλλο, για να 

δημιουργηθεί το animation. 

  

 

Frame 1    

 Frame 50 

 

Βήμα 12ο: Στο layer 2 κάντε δεξί κλικ πάνω σε ένα οποιοδήποτε frame ανάμεσα από 

το 1 και το 50 και επιλέξτε «Create Motion Tween». 
 

 

 

 

Βήμα 13ο: Επιλέξτε το frame 1 για να τοποθετήσετε την κεφαλή της ταινίας στην 

αρχή και στη συνάχεια με δεξί κλικ στο layer 2, ενεργοποιήστε ξανά την επιλογή 

«Mask». 

Πατήστε «ENTER» για να αναπαράγετε το animation κινούμενης μάσκας. 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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Δραστηριότητα 5: Εφαρμογή σε σύνθετα animations 

Με την μέθοδο «Motion Tween»  δημιουργήσατε τα ενδιάμεσα καρέ κίνησης του 

animation. Αυτή η μέθοδος, όμως, περιορίζει την κίνηση μόνο σε μια νοητή γραμμή, 

από την θέση του αντικειμένου στο πρώτο frame μέχρι την θέση του στο τελευταίο 

frame. 

Εφαρμόζοντας τον οδηγό κίνησης (Motion guide) πάνω σε ένα layer, θα μάθετε να 

φτιάχνετε κάποια πιο σύνθετη διαδρομή, στην οποία θα κινείται το animation. 

 

Βήμα 1ο: Κάντε δεξί κλικ πάνω στο layer 1 και 

ενεργοποιήστε την επιλογή «Add Motion Guide» 

 

Στο στρώμα «Guide: Layer 1» θα σχεδιαστεί η 

διαδρομή του αντικειμένου και στο στρώμα «Layer 

1» το αντικείμενο που θα ακολουθήσει την διαδρομή  

της κίνησης. 

Βήμα 2ο : Επιλέξτε το Guide: Layer 1 και με το «pencil 

tool», σχεδιάστε μια διαδρομή, όπου θα περνάει το 

κινούμενο αντικείμενό σας. Προσπαθήστε να φτιάξετε μια 

διαδρομή παρόμοια με αυτή  της διπλανής εικόνας. 

Βήμα 3ο : Επιλέξτε το Layer 1 και σχεδιάστε με την 

βοήθεια του «oval tool» έναν μικρό χρωματιστό κύκλο. 

 

Βήμα 3ο : Πατήστε δεξί κλικ στο frame 40 και εισάγετε «keyframes» 

και στα 2 Layers αντίστοιχα. 

 

Βήμα 4ο :Επιλέξτε το layer του αντικειμένου (layer 1) και, αφού 

βάλετε την κεφαλή της ταινίας στο frame 1, σύρτε τον κύκλο και 

τοποθετήστε τον στην άκρη της διαδρομής. 

Βήμα 5ο: Τοποθετήστε τώρα την κεφαλή στο τελευταίο frame (frame 40) και σύρτε 

τον κύκλο στην άλλη άκρη της διαδρομής. 

Βήμα 6ο: Δημιουργήστε τα ενδιάμεσα καρέ της κίνησης στο layer 1 με την χρήση του 

«Motion Tween», γυρίστε την κεφαλή αναπαραγωγής στο frame 1 και πατήστε 
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απόκρυψη του layer οδηγού, για να μην εμφανίζεται η διαδρομή. Τώρα αναπαράγετε 

το animation πατώντας «ENTER» 

Ποια διαδρομή ακολουθεί το αντικείμενο; 

…………………………………………………………………………………………

………………………………………………………………………………………… 

Τι θα συμβεί  αν σχεδιάσουμε  ένα άλλο αντικείμενο; 

…………………………………………………………………………………………

………………………………………………………………………………………… 

Τι θα συμβεί αν κάνουμε αντιστροφή των καρέ; 

…………………………………………………………………………………………

………………………………………………………………………………………… 
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Φύλλο εργασίας  
 

5. Βασικές ενέργειες και χρήση των κουμπιών στο Flash  

 
Όνομα: 
Τάξη: 
Διάρκεια: 2 διδακτικές ώρες 
 
 
Διδακτικοί στόχοι: 

Με το συγκεκριμένο φύλλο εργασίας  θα είστε ικανοί να:  
 

 γνωρίζετε το πάνελ «Actions» και τις βασικές δυνατότητες του 
actionscripting 

 προσθέτετε ενέργειες σε καρέ   
 δημιουργείτε ετικέτες σε καρέ  
 δημιουργείτε βασικά κουμπιά 
 δημιουργείτε slideshow 

 
 
 

Δραστηριότητα 1: Κατανόηση του πάνελ «Actions» και των βασικών 
δυνατοτήτων του actionscripting  

Αν και κάποιες μορφές διαδραστικότητας επιτυγχάνονται και χωρίς προγραμματισμό, 
ωστόσο σε πιο περίπλοκες περιπτώσεις χρειάζεται να γραφτεί κώδικας.  
Στην εφαρμογή Flash χρησιμοποιείται η γλώσσα προγραμματισμού ActionScript και 
τα scripts ενσωματώνονται στο αρχείο Flash. Για τη δημιουργία τους χρησιμοποιείται 
το πάνελ «Actions». Το πάνελ «Actions» περιέχει συντάκτη κώδικα έτσι ώστε να 
διευκολύνει τον προγραμματιστή στη σύνταξη κώδικα. 
Βήμα 1ο. Σε ένα καινούργιο αρχείο για να ανοίξετε το πάνελ «Actions» επιλέγετε 
«Window > Actions». Το πάνελ «Actions» αποτελείται από τρία μέρη (panes) – 
«Λίστα κατηγοριών» (Actions toolbox), «Λίστα των scripts» (Script navigator) και 
«Περιοχή script» (Script pane). 
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Βήμα 2ο. Από την αναδιπλούμενη λίστα πάνω αριστερά, η οποία περιέχει 
διαφορετικές εκδόσεις του ActionScript, επιλέξτε τη γραμμή ActionScript 1.0 & 2.0. 
Το «Action toolbox» εμφανίζει τα στοιχεία του ActionScript κατηγοριοποιημένα. Για 
την εισαγωγή ενός στοιχείου στο «Script pane» πρέπει να κάνετε διπλό κλικ πάνω 
του ή να το σύρετε εκεί με το ποντίκι. Επιλέξτε «Global Functions > Timeline 
Control». Θα δείτε την εντολη «stop». Κάντε διπλό κλικ πάνω της. Η  εντολη θα 
εμφανισθεί στο «Script pane». Κάποιες εντολές απαιτούν παραμέτρους και κάποιες 
όχι. Για να καταλάβετε αν η συγκεκριμένη εντολή απαιτεί παραμέτρους, κάντε κλικ 
ανάμεσα στις παρενθέσεις και ύστερα κάντε κλικ στο εικονίδιο «Show code hint»:  

 
Στο «Script pane» μέσα σε ένα κουτάκι θα δείτε «stop();», που σημαίνει, ότι δεν 
χρειάζονται παράμετροι.  

 
Βήμα 3ο. Κάντε διπλό κλικ πάνω στην εντολή «gotoAndPlay». Η εντολη θα 
εμφανισθεί στο «Script pane». Για να καταλάβετε αν η συγκεκριμένη εντολή απαιτεί 
παραμέτρους, όπως και στην προηγούμενη περίπτωση, κάντε κλικ ανάμεσα στις 
παρενθέσεις και ύστερα κάντε κλικ στο εικονίδιο «Show code hint». Θα δείτε  στις 
παρενθέσεις  «frame», που σημαίνει ότι χρειάζεται παράμετρος – αριθμός κάποιου 
καρέ. 

 
Βήμα 4ο. Εισάγετε «1» ανάμεσα στις παρενθέσεις και ύστερα κάντε κλικ πάνω στο 
«Script Assist». Θα δείτε  τις εξηγήσεις για την εντολή: 
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Μέσα στο «Script pane» μπορείτε να πληκτρολογήσετε και κατευθείαν τον κώδικά 
σας. Μπορεί να συνδυάζεται η αυτόματη εισαγωγή κώδικα με την πληκτρολόγησή 
του.  
Το «Script navigator» βοηθάει στην εντόπιση του κώδικα στην ταινία. Κάντε κλικ 
πάνω στο «Layer 1: Frame 1». Δεξιά στο «Script pane» είναι ο κώδικας που 
αντιστοιχεί στο καρέ 1 «Frame 1» του επιπέδου 1 «Layer 1»: 

 
Μπορείτε να γράφετε κώδικα σε οποιοδήποτε καρέ οποιουδήποτε movieclip. 
Ωστόσο, η πρακτική που προτείνει η κατασκευάστρια εταιρεία και εγκρίνει η 
κοινότητα των προγραμματιστών είναι να συγκεντρώνεται όλος ο κώδικας σε ένα 
καρέ 
Χωρίς τη γλώσσα  ActionScript η ταινία θα αναπαράγεται κάθε φορά με τον ίδιο 
τρόπο. Η χρήση της γλώσσας  ActionScript επιτρέπει την διαφοροποίηση μίας 
ταινίας, ανάλογα με την αλληλεπίδραση του χρήστη με τα στοιχεία της ταινίας ή 
ανάλογα με χρονικές ρυθμίσεις ή δεδομένα προερχόμενα από μία εξωτερική πηγή. 
Στις παρακάτω δραστηριότητες θα εφαρμόσετε τη γλώσσα  ActionScript για κάτι από 
αυτά που αναφέρθηκαν. 
Δοκιμάστε να εισάγετε στο «Script pane» και άλλες ενέργειες από την κατηγορία 
«Timeline Control» και να χρησιμοποιήσετε το «Show code hint» και το «Script 
Assist» γι αυτές. 
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Δραστηριότητα 2: Προσθήκη ενεργειών σε καρέ   

Υπάρχουν 2 εκδόσεις της γλώσας ActionScript:  η ActionScript 2.0 και η 
ActionScript 3.0 Η ActionScript 3.0 είναι πιο γρήγορη όταν εκτελείται, αλλά η 
ActionScript 2.0 χρησιμοποιείται ακόμα πολύ και η εκμάθησή του είναι πιο εύκολη. 
Τα παρακάτω παράδειγματα υλοποιούνται με την ActionScript 2.0. 
Όταν μία ενέργεια προστίθεται σε ένα καρέ, το Flash την ακολουθεί, όταν η κεφαλή 
εκτέλεσης φτάνει σ’ αυτό το συγκεκριμένο καρέ.  
Για να προσθέσετε μία ενέργεια σε ένα καρέ, ακολουθείστε τα εξής βήματα: 
Βήμα 1ο. Επιλέξτε ActionScript 1.0 & 2.0 από την αναδιπλούμενη λίστα στο 
«Actions toolbox».   
Βήμα 2ο. Σε ένα καινούργιο αρχείο Flash ονομάστε το υπάρχον επίπεδο 
«Animation».  
Βήμα 3ο. Δημιουργήστε μία ενότητα κειμένου με τη λέξη «Welcome».  

 
Ο τύπος του κειμένου να είναι Static και ως χρώμα του κειμένου επιλέξτε κόκκινο.  

 
Επιλέξτε το κείμενο και μετατρέψτε το σε σύμβολο με το όνομα WelcomeText και με 
συμπεριφορά Movie Clip.  

 
Βήμα 4ο. Τώρα έχετε ένα στιγμιότυπο του συμβόλου αυτού στη σκηνή. Τοποθετήστε 
το στο κέντρο της σκηνής και εισάγετε καρέ-κλειδιά στα καρέ 20 και 30. 
 

  
Βήμα 5ο. Κάντε κλικ στο καρέ 1, επιλέξτε το στιγμιότυπο του συμβόλου στη σκηνή 
και εφαρμόστε σ’αυτό μπλε χρώμα («Tint»).  

 
Βήμα 6ο. Κάντε κλικ σε οποιοδήποτε καρέ ανάμεσα στο 20 και 30 στη χρονογραμμή.  
Βήμα 7ο. Στο πάνελ Properties από την αναδιπλούμενη λίστα Tween επιλέξτε Motion 
και από την αναδιπλούμενη λίστα Rotate επιλέξτε CW (δεξιόστροφη περιστροφή).  
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Βήμα 8ο. Για να δοκιμάσετε την ταινία, επιλέγοντας «Control > Test Movie». Θα 
δείτε, ότι ολόκληρη η ταινία επαναλαμβάνεται διαρκώς. Τώρα θα διαμορφώσετε την 
ταινία έτσι ώστε να επαναλαμβάνει μόνο το τμήμα που περιέχει την περίστροφή.  
Βήμα 9ο. Δημιουργήστε καινούργιο επίπεδο (layer) και ονομάστε το «Actions».  
Βήμα 9ο. Επιλέξτε το καρέ 30 στο επίπεδο «Actions», εισάγετε καρέ-κλειδί και 
εμφανίστε την παλέτα «Actions». Θα παρατηρήσετε ότι η καρτέλα λέει «Actions:30». 
Αυτό σημαίνει, ότι ο αντίστοιχος κώδικας θα αφορά το καρέ 30 του επιπέδου 
«Actions». Θα καθορίσετε μία ενέργεια, η οποία θα εκτελείται όταν η κεφαλή 
εκτέλεσης φτάνει στο καρέ 30. 
 
Βήμα 9ο.  Αριστερά στο πάνελ «Actions» βλέπετε «Actions toolbox». Επιλέξτε 
«Global Functions > Timeline Control». Μετά κάντε διπλό κλικ στο «gotoAndPlay» 
για να εισάγετε αυτό το στοιχείο στο «Script pane».  
 
Βήμα 10ο.  Στο «Script pane» εμφανίστηκε η εντολή «gotoAndPlay();». Μένει να 
εισάγετε εσείς μία παράμετρο στις παρενθέσεις. Εισάγετε «20». Αυτή η εντολή 
σημαίνει, ότι η ταινία, όταν θα φτάσει στο καρέ 30, θα μεταφερθεί αμέσως στο καρέ 
20.  

 
Βήμα 11ο.  Για να δείτε τι δημιουργήσατε επιλέξτε «Control > Test Movie». 
 
Αν σέρνατε στη χρονογραμμή το καρέ-κλειδί από το 20 σε 18 και θέλατε η ταινία να 
επαναλαμβάνει το τμήμα από την αρχή της κίνησης, τι αλλαγή θα έπρεπε να κάνετε 
στον κώδικα; 
..........................................................................................................................................
..........................................................................................................................................
..........................................................................................................................................
..........................................................................................................................................
.......................................................................................................................................... 
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Δραστηριότητα 3: Δημιουργία ετικετών σε καρέ   

Μπορείτε να βελτιώσετε την ενέργεια «gotoAndPlay» παρέχοντας μια ετικέτα καρέ 
αντί του αριθμού καρέ ως προορισμό της ενέργειας.  
Βήμα 1ο.  Στο αρχείο που δημιουργήσατε στην προηγούμενη δραστηριότητα, κάντε 
κλικ στο καρέ 20 του επιπέδου Animation. Στο πάνελ «Properties» θα δείτε ένα 
πεδίο, στο οποίο μπορείτε να εισάγετε μία ετικέτα γι’ αυτό το καρέ. Πληκτρολογήστε 
εκεί «LoopStart».  

 
 
Βήμα 2ο. Κάντε κλικ στο καρέ 30 στο επίπεδο «Actions» και ανοίξτε την παλέτα 
«Actions».  
Βήμα 3ο. Στην ενέργεια  «gotoAndPlay» αλλάξτε το 20 σε «LoopStart». Το τελικό  
script πρέπει να είναι:  

gotoAndPlay(“LoopStart”); 
Βήμα 4ο. Για το χρήστη η ταινία δεν θα τρέξει διαφορετικά. Όμως τώρα μπορείτε να 
σύρετε την ετικέτα σε άλλο καρέ χωρίς να αλλάξετε το script σας.  Κάντε κλικ στη 
χρονογραμμή στο καρέ 20 και σύρετέ το έτσι ώστε το Loop Start να είναι τώρα το 
καρέ 10.  
Βήμα 5ο. Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». 
 
Ποια είναι κατά την άποψή σας τα πλεονεκτήματα της χρήσης ετικέτας καρέ αντί του 
αριθμού καρέ; 
..........................................................................................................................................
..........................................................................................................................................
..........................................................................................................................................
..........................................................................................................................................
..........................................................................................................................................
.......................................................................................................................................... 
 

Δραστηριότητα 4: Δημιουργία βασικών κουμπιών  

Τα κουμπιά είναι διαλογικά (interactive) movie clips που αποτελούνται από τέσσερα 
καρέ. Όταν δημιουργείτε ένα σύμβολο και επιλέγετε τη συμπεριφορά του ως κουμπί, 
το Flash δημιουργεί τη χρονογραμμή με τέσσερα καρέ.  
Κάθε καρέ στη χρονογραμμή ενός κουμπιού αντιστοιχεί σε συγκεκριμένη λειτουργία: 

 Το πρώτο καρέ – κατάσταση «Up» – ο δείκτης του ποντικιού δεν είναι πάνω 
από το κουμπί 

 Το δεύτερο καρέ – κατάσταση «Over» - ο δείκτης του ποντικιού είναι πάνω 
από το κουμπί 

 Το τρίτο καρέ – κατάσταση «Down» – όταν γίνεται κλικ στο κουμπί 

 Το τέταρτο κουμπί – κατάσταση «Hit» – ορίζει την περιοχή που 
ανταποκρίνεται στο κλικ και δεν είναι ορατή στην ταινία SWF 
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Για να δημιουργήσετε ένα κουμπί, ακολουθήστε τα εξής βήματα: 
Βήμα 1ο.  Σε ένα καινούργιο αρχείο Flash σχεδιάστε ένα ορθογώνιο. Επιλέξτε το (με 
διπλό κλικ) και μετατρέψτε το σε σύμβολο. Δώστε του όνομα «MyButton» και 
επιλέξτε τη συμπεριφορά κουμπιού (Behavior: Button).  

 
 
Βήμα 2ο. Επιλέξτε «Control > Test Movie». Θα δείτε πώς αλλάζει ο δεικτης του 
ποντικιού, όταν τον τοποθετείτε επάνω στο κουμπί. Μετά κλείστε το παράθυρο με 
την ταινία «SWF». 
 
Βήμα 3ο. Για να ορίσετε διάφορες καταστάσεις του κουμπιού, βεβαιωθείτε ότι στο 
μενού «Control» δεν είναι μαρκαρισμένη η εντολή «Enable Simple Buttons» και 
κάντε διπλό κλικ στο στιγμιότυπο του κουμπιού για να προσπελάσετε το πρωτότυπο 
σύμβολό του.  
 
Βήμα 4ο. Θα παρατηρήσετε ότι το σύμβολο έχει μόνο τέσσερα καρέ, τα οποία αντί να 
είναι αριθμημένα, έχουν ονόματα: «Up», «Over», «Down» και «Hit».  

 
Η κατάσταση «Up» περιέχει ήδη την κανονική (μη-επιλεγμένη) εμφάνιση του 
κουμπιού. Για να δημιουργήσετε την εμφάνιση του κουμπιού στην κατάσταση 
«Over», εισάγετε ένα καρέ-κλειδί στο δεύτερο καρέ του κουμπιού. (Κάντε κλικ στο 
καρέ της χρονογραμμής κάτω από το όνομα «Over» και μετατρέψτε το σε καρέ-
κλειδί πατώντας «F6» ή επιλέξτε «Insert > Timeline > Keyframe»). Επιλέξτε το 
εργαλείο Γεμίσματος και διαλέξτε ένα χρώμα παρόμοιο, αλλά ελαφρώς φωτεινότερο 
από το υπάρχον χρώμα του κουμπιού σας. Γεμίστε το σχήμα της κατάστασης «Over» 
με το χρώμα που επιλέξατε.  
 
Βήμα 5ο. Εισάγετε ένα καρέ-κλειδί στο καρέ της κατάστασης «Down».  
Βήμα 6ο. Επιλέξτε όλο το περιεχόμενο του καρέ «Down» και μετακινήστε το σχήμα 
προς τα κάτω και δεξιά κατά τρία pixels πατώντας τρεις φορές τα αντίστοιχα βελάκια.  

 
 
Βήμα 7ο. Η κατάσταση Hit δεν γίνεται αντιληπτή από το χρήστη. Ορίζει την ενεργή 
περιοχή του κουμπιού. Είναι χρήσιμο να την ορίζετε όταν έχετε πολύ μικρό κουμπί ή 
όταν το κουμπί σας έχει σχήμα, για παράδειγμα, δακτυλιδιού (δηλαδή με κενό στη 
μέση) και χρειάζεται να ανταποκρίνεται οπουδήποτε το επιλέξει ο χρήστης μέσα στο 
κενό. Στη δική σας περίπτωση, όπου το κουμπί έχει σχήμα ορθογωνίου δεν χρειάζεται 
να ορίσετε την κατάσταση Hit. Θα την ορίσετε στην παρακάτω άσκηση.   
Βήμα 8ο. Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». Το κουμπί 
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σας  ανταποκρίνεται στις μετακινήσεις του ποντικιού, αλλά ακόμα δεν 
ανταποκρίνεται σε κλικ. Για να γίνει αυτό, χρειάζεται να του αναθέσετε ενέργεια. 
Αυτό θα γίνει στην επόμενη δραστηριότητα. 
Ποιες είναι οι βασικές καταστάσεις ενός κουμπιού και ποια είναι η χρησιμότητα της 
κατάστασης «Hit»; 
..........................................................................................................................................
..........................................................................................................................................
..........................................................................................................................................
..........................................................................................................................................
..........................................................................................................................................
.......................................................................................................................................... 
 
Δημιουργήστε ένα κουμπί, όπως στα παραπάνω βήματα, σχεδιάζοντας τη λέξη 
«Home» με το εργαλείο «Κειμένου» αντί για το ορθογώνιο. Ορίστε και τις τέσσερεις 
καταστάσεις του κουμπιού. Για την κατάσταση «Hit» σχεδιάστε μία έλλειψη. 
 

Δραστηριότητα 5: Δημιουργία slideshow   

Οι εικόνες, από τις οποίες πρόκειται να δημιουργήσετε slideshow, πρέπει να είναι σε 

κατάλληλη μορφή. Η καλύτερη μορφή για τις φωτογραφίες είναι JPEG. Για καλύτερα 

αποτελέσματα πρέπει να είναι μεγέθους 640 x 480 pixels και πρέπει να είναι 

αριθμημένες, για παράδειγμα, ως photo1.jpg, photo2.jpg, και photo3.jpg. 

Βήμα 1ο.  Επιλέξτε «File > New» για να δημιουργήσετε μια νέα εφαρμογή flash. Στο 
παράθυρο διαλόγου επιλέξτε την καρτέλα «Templates», από το διαθέσιμα Templates 
επιλέξτε το Template «Photo Slideshows» και πατήστε «OK». Το flash δημιουργεί 
μια νέα εφαρμογή. Αυτή η εφαρμογή περιέχει τέσσερεις φωτογραφίες. Επίσης, 
περιέχει και ένα control με το οποίο μπορείτε να δείτε τις φωτογραφίες με τη σειρά, 
στη μορφή slide-show. 
 

 
Βήμα 2ο.  Τρέξτε την εφαρμογή (πατώντας control και enter) για να εξοικειωθείτε με 
τη λειτουργία της.  
Βήμα 3ο.  Επιλέξτε το επίπεδο, το οποίο έχει όνομα «picture layer» και διαγράψτε το.  
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Βήμα 4ο.  Δημιουργήστε καινούργιο επίπεδο και δώστε του όνομα «My Photos».  
Βήμα 5ο.  Τοποθετήστε το επίπεδο «My Photos» κάτω από όλα τα υπόλοιπα επίπεδα.  
 

 
Βήμα 6ο.  Επιλέξτε το πρώτο καρέ-κλειδί στο επίπεδο «My Photos» και ύστερα 
επιλέξτε «File > Import > Import to Stage». Εντοπίστε τις φωτογραφίες, οι οποίες θα 
σας δωθούν μαζί με το παρόν φύλλο εργασίας. Επιλέξτε την πρώτη φωτογραφία, 
πατήστε «Open» και ύστερα «Yes» στο παράθυρο που θα εμφανισθεί: 

 
Το Flash θα τοποθετήσει τις φωτογραφίες σας σε ξεχωριστά καρέ-κλειδιά.  
Βήμα 7ο.  Διαγράψτε τις παλιές φωτογραφίες από τη Βιβλιοθήκη.  
Βήμα 8ο.  Στο επίπεδο «My Photos» τοποθετήστε κάθε φωτογραφία στο κέντρο της 
σκηνής (stage) στα αντίστοιχα καρέ-κλειδιά.  
Βήμα 9ο.  Στο επίπεδο «Captions» αλλάξτε τις λεζάντες για κάθε φωτογραφία στα 
αντίστοιχα καρέ-κλειδιά.  
Βήμα 10ο.  Στο επίπεδο «Title, Date» αλλάξτε τον τίτλο του άλμπουμ και δίπλα 
γράψτε την ημερομηνία.  
Βήμα 11ο.  Οι φωτογραφίες θ’ αλλάζουν κάθε 4 δευτερόλεπτα. Υπάρχει  δυνατότηα 
να αλλάξετε αυτή τη ρύθμιση. Επιλέξτε το στιγμιότυπο του flash component «mc, 
controller», το οποίο έχει βελάκια «next» και «previous» (βρίσκεται στο επίπεδο 
«_controller»). Ανοίξτε το «Component inspector» επιλέγοντας «Window > 
Component Inspector». Η καρτέλα «Parameters» θα είναι προεπιλεγμένη. Αλλάξτε 
«4» σε «5».  
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Βήμα 12ο.  Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». 



ΤΕΤΡΑΔΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 59 

Φύλλο εργασίας  

6. Εξαγωγή των ταινιών του Flash  

 

Όνομα: 

Τάξη: 

Διάρκεια: 2 διδακτικές ώρες 

 

Διδακτικοί στόχοι: 

Μετά την ολοκλήρωση των εκπαιδευτικών δραστηριοτήτων θα είστε ικανοί να:   

 εξάγετε τις ταινίες του Flash 

 ελέγχετε τοποθέτηση και ενσωμάτωση του flash αντικειμένου σε 

φυλλομετρητή (browser)  

 ρυθμίζετε το Flash Player   

 

 

Δραστηριότητα 1: Εξαγωγή ταινιών του Flash 

Για τη δημοσίευση μιας ταινίας του Flash στο Web απαιτούνται τα παρακάτω 

βήματα: 

Βήμα 1ο: Σε ένα καινούργιο αρχείο σχεδιάστε ένα ορθογώνιο που να καταλαμβάνει 

περίπου όλη τη σκηνή. 

 

Βήμα 2ο: Αποθηκεύστε το αρχείο σας με το όνομα «my_movie.fla» στο φάκελο 

«fla_files», τον οποίο δημιουργείτε μέσα στο φάκελο «My Documents».  

Βήμα 3ο: Για να εξάγετε την ταινία σας, επιλέξτε «File > Publish». Θα 

δημιουργηθούν αρχεία «swf» και «html» με το ίδιο όνομα «my_movie», αλλά με 

διαφορετική επέκταση, μέσα στον ίδιο φάκελο: «my_movie.swf» και 

«my_movie.html». 
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Ποιος άλλος τρόπος υπάρχει για τη δημιουργία του αρχείου «my_movie.swf» από το 

αρχείο «my_movie.fla»; 

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Δραστηριότητα 2: Έλεγχος τοποθέτησης και ενσωμάτωσης του αντικειμένου σε 
φυλλομετρητή (browser) 

Κατά τη δημοσίευση μιας ταινίας του Flash μπορείτε να ελέγχετε την τοποθέτηση και 

την ενσωμάτωση της σε φυλλομετρητή (browser). Ακολουθήστε τα εξής βήματα: 

Βήμα 1ο: Έχοντας ανοικτό το αρχείο «my_movie.fla» από την προηγούμενη 

δραστηριότητα, επιλέξτε «File > Publish Settings». Οποιεσδήποτε αλλαγές κάνετε 

στο παράθυρο διαλόγου «Publish Settings»,  θα αποθηκευτούν σ’ αυτό το αρχείο. Στο 

παράθυρο διαλόγου «Publish Settings» θα είναι προεπιλεγμένη η καρτέλα «Formats». 

Βεβαιωθείτε ότι οι μόνες ενεργοποιημένες επιλογές είναι οι «Flash» και «HTML». 

Κάντε κλικ στο «OK». 

 

Βήμα 2ο. Κάντε κλικ στην καρτέλα «Flash» του παραθύρου διαλόγου. Από την 

αναδιπλούμενη λίστα «Version:» επιλέξτε «Flash Player 6». Αυτό σημαίνει, ότι η 

ταινία σας θα μπορεί να προβληθεί στα συστήματα των χρηστών που έχουν πρόσθετο 

για το «Flash Player 6» ή μεταγενέστερη έκδοση. 
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Βήμα 3ο: Κάντε κλικ στην καρτέλα «HTML». Κάθε ρύθμιση που υπάρχει σ’ αυτήν 

την καρτέλα (εκτός της ρύθμισης «Device Fonts») επηρεάζει μόνο το παραγόμενο 

HTML αρχείο. Από την αναδιπλούμενη λίστα «Template» επιλέξτε «Flash Only».  

Βήμα 4ο: Ορίστε την επιλογή «Dimensions:» σε «Percent» και πληκτρολογήστε 100 

στα πεδία «Width» (πλάτος) και «Height» (ύψος), έτσι ώστε η ταινία να 

καταλαμβάνει ολόκληρο το παράθυρο του φυλλομετρητή. Βεβαιωθείτε, ότι τα 

πλαίσια ελέγχου «Loop» (επανάληψη) και «Display Menu» (εμφάνιση μενού) δεν 

είναι μαρκαρισμένα.  

Βήμα 5ο. Για να τοποθετηθεί η ταινία σας στη μέση του παραθύρου, αφήστε την 

προεπιλεγμένη ρύθμιση «Center» για το «Flash alignment» - «Horizontal» και 

«Vertical». 
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Βήμα 6ο: Κάντε κλικ στο OK. Οι ρυθμίσεις δημοσίευσης αποθηκεύονται.  

Βήμα 7ο: Επιλέξτε «File > Publish».  

Βήμα 8ο: Ανοίξτε το αρχείο «my_movie.html» σε ένα φυλλομετρητή για να δείτε τα 

αποτελέσματα των ρυθμίσεων. 

 

Κάντε μεγέθυνση ή σμίκρυνση του παραθύρου του φυλλομετρητή. Βεβαιωθείτε, ότι η 

ταινία καταλαμβάνει ολόκληρο το παράθυρο και βρίσκεται στη μέση του, όποιο 

μέγεθος και αν έχει το παράθυρο. 

Στη συνέχεια, εξετάστε τον κώδικα του παραγόμενου HTML αρχείου 

«my_movie.html» στο Dreamweaver.  
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Δραστηριότητα 3: Ρυθμίσεις του Flash Player 

Ένα Flash Player αναπαράγει την ταινία με τον ίδιο τρόπο, όπως ένας φυλλομετρητής 

(browser).  

Βήμα 1ο: Στο αρχείο «my_movie.fla», με το οποίο δουλεύατε στις προηγούμενες 

δραστηριότητες, κάντε διπλό κλικ πάνω στο ορθογώνιο και μετατρέψτε το σύμβολο 

με τη συμπεριφορά Movie Clip.  

Βήμα 2ο: Εισάγετε ένα καρέ-κλειδί στο καρέ 40 της χρονογραμμής. Κάντε κλικ σ’ 

αυτό το καρέ. Με το εργαλείο «Free Transform Tool» κάντε το στιγμιότυπο του 

ορθογωνίου περίπου 2 φορές μικρότερο. 

 

Βήμα 3ο: Κάντε δεξί κλικ σε οποιοδήποτε καρέ μεταξύ των καρέ 1 και 40 και 

επιλέξτε «Create Motion Tween». 

Βήμα 4ο: Επιλέξτε «File > Save» και ύστερα «File > Publish». 

Βήμα 5ο: Στο φάκελο «fla_files», τον οποίο δημιουργήσατε στη Δραστηριότητα 1 

του παρόντος Φύλλου εργασίας, κάντε κλικ πάνω στο αρχείο  «my_movie.swf». Το 

αρχείο θα ανοίξει στην εφαρμογή  Flash Player.  

Βήμα 6ο: Για να αλλάξετε τη μεγέθυνση, δοκιμάστε διαδοχικά  «View > Zoom In» 

και «View > Zoom Out». Επιλέξτε «View > Full Screen». Η ταινία θα καταλάβει όλη 

την οθόνη. Πατήστε το κουμπί «Esc» για να επιστρέψετε στην προηγούμενη 

εμφάνιση. 
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Βήμα 7ο: Επιλέξτε «Control» και, αν το πλαίσιο ελέγχου «Loop» (επανάληψη) είναι 

μαρκαρισμένο, αποεπιλέξτε το. Επιλέξτε «Control > Play» και ύστερα «Control > 

Rewind». Δοκιμάστε διαδοχικά  «Control > Step Forward» και «Control > Step 

Back». Παρακολουθήστε τι γίνεται με την αναπαραγωγή της ταινίας κάθε φορά.  

 

 

Επιλέξτε το πλαίσιο ελέγχου «Loop». Η ταινία θα επαναλαμβάνεται συνεχώς. 

 

Στην περίπτωση δημοσίευσης της ταινίας με χρησιμοποίηση του παραθύρου 

διαλόγου «Publish Settings», ποια ρύθμιση θα έκανε την ταινία να επαναλαμβάνεται 

συνεχώς στο φυλλομετρητή (browser); 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 
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Φύλλο εργασίας  

7. Περισσότερα για τη χρήση των κουμπιών στο Flash  

 
Όνομα: 
Τάξη: 
Διάρκεια: 2 διδακτικές ώρες 
 
 
Διδακτικοί στόχοι: 

Με το συγκεκριμένο φύλλο εργασίας  θα είστε ικανοί να:  
 

 αναθέτετε ενέργειες σε κουμπιά 
 δημιουργείτε κουμπιά με κίνηση (animated buttons) 
 εισάγετε δεδομένα με πληκτρολόγιο   

 
 

 

Δραστηριότητα 1: Ανάθεση ενεργειών σε κουμπιά   

Σ’ αυτή τη δραστηριότητα θα δημιουργήσετε κουμπιά, τα οποία θα επιτρέπουν στο 
χρήστη να σταματά και να συνεχίζει μία ταινία. 
Βήμα 1ο.  Μπορείτε να χρησιμοποιήσετε το αρχείο με το animation, το οποίο 
δημιουργήσατε στη δραστηριότητα 3 του φύλλου εργασίας 3. Αν δεν το έχετε, 
δημιουργήστε το, όπως περιγράφεται εκεί.   
Βήμα 2ο. Δημιουργήστε καινούργιο επίπεδο (layer) και ονομάστε το «Buttons».  
Βήμα 3ο. Στο επίπεδο «Buttons» δημιουργήστε ένα κουμπί, όπως περιγράφεται στο 
φύλλο εργασίας 5 .  
Βήμα 4ο. Θα χρειαστείτε δύο κουμπιά στη σκηνή. Γι’ αυτό αντιγράψτε και 
επικολλήστε (copy and paste) το στιγμιότυπό του κουμπιού, το οποίο βρίσκεται ήδη 
στη σκηνή. Εφαρμόστε ένα διαφορετικό στυλ χρώματος (Tint) σε κάθε στιγμιότυπο, 
όπως μάθατε στη δραστηριότητα 2 του φύλλου εργασίας 3 – κόκκινο για το κουμπί 
«Stop» και πράσινο για το κουμπί «Play».  

 
Βήμα 5ο. Δώστε σε κάθε κουμπί ονόματα «red» και «green» αντίστοιχα, 
χρησιμοποιώντας το πάνελ Properties.  
Βήμα 6ο. Τώρα πρέπει να αναθέσετε μία ενέργεια σε κάθε κουμπί. Πληκτρολογήστε 
τον παρακάτω κώδικα στο πάνελ «Actions» για το πρώτο καρέ-κλειδί της ταινίας: 

red.onPress = function () { 
         stop (); 
} 
green.onPress = function () { 
         play (); 
} 

Βήμα 7ο. Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». Θα δείτε, 
ότι όταν πατήσετε τα κουμπιά, η ταινία θα αναπαράγεται και θα σταματά. 



ΤΕΤΡΑΔΙΟ ΜΑΘΗΤΗ                                                                     FLASH 

 

 
CONCEPTUM AE                                                                                                 66 

 
Δημιουργήστε ένα κουμπί, δώστε του όνομα «MyButton» και αναθέστε του την 
ενέργεια   
 

«getURL("http://www.adobe.com", "_blank");», 
 

η οποία θα ανοίξει την ιστοσελίδα «adobe.com» σε ένα καινούργιο παράθυρο του 
φυλλομετρητή (browser), όταν  πατήσετε το κουμπί αυτό. 
  

Δραστηριότητα 2: Κουμπιά με κίνηση (animated buttons) 

Μπορείτε να δημιουργήσετε ένα κουμπί με κίνηση (animated button), το οποίο θα 
κινείται διαρκώς. Ή μόνο όταν ο δείκτης του ποντικιού είναι πάνω του. Απλώς 
τοποθετείτε το επιθυμητό movie clip στις κατάλληλες καταστάσεις του κουμπιού. 
Σ’ αυτή τη δραστηριότητα θα δημιουργήσετε ένα κουμπί που κινείται, όταν ο 
χρήστης περνά το ποντίκι από επάνω του: 
Βήμα 1ο:  Σε ένα καινούργιο αρχείο  χρησιμοποιήστε το εργαλείο Κειμένου για να 
πληκτρολογήστε τη λέξη Home στη σκηνή. Στο πάνελ Properties ορίστε 30 ως 
μέγεθος του κειμένου. Επιλέξτε το κείμενο και μετατρέψτε το σε σύμβολο, δώστε του 
όνομα «HomeText» και διατηρήστε τη συμπεριφορά «Movie Clip». 

 
 
Βήμα 2ο: Το κείμενο που είναι στη σκηνή είναι ένα στιγμιότυπο του συμβόλου 
αυτού. Τώρα θα δημιουργήσετε ένα σύμβολο, το οποίο θα κινεί το σύμβολο 
«HomeText» στη σκηνή. Επιλέξτε το στιγμιότυπο που έχετε στη σκηνή και 
μετατρέψτε το σε σύμβολο, δώστε του όνομα «HomeAnimation». 

 
 
Βήμα 3ο: Κάντε διπλό κλικ πάνω στο στιγμιότυπο του συμβόλου «HomeAnimation» 
που έχετε στη σκηνή για να προσπελάσετε το πρωτότυπο σύμβολό του.  
Βήμα 4ο:  Εισάγετε ένα καρέ-κλειδί στο καρέ 30 και ένα καρέ-κλειδί στο καρέ 15. 
Μεγαλώστε το στιγμιότυπο του συμβόλου «HomeText» στο καρέ 15. Κάντε δεξί κλικ 
σε οποιοδήποτε καρέ μεταξύ των καρέ 1 και 15 και επιλέξτε «Create Motion Tween». 
Ύστερα κάντε δεξί κλικ σε οποιοδήποτε καρέ μεταξύ των καρέ 15 και 30 και πάλι 
επιλέξτε «Create Motion Tween». 
Βήμα 5ο:  Επιστρέψτε στην κύρια σκηνή κάνοντας κλικ στην ένδειξη «Scene 1» 
επάνω αριστερά. Επιλέξτε «Edit > Select All» και μετά «Edit > Clear». Ανοίξτε τη 
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βιβλιοθήκη επιλέγοντας «Window > Library» και σύρετε ένα στιγμιότυπο του 
συμβόλου «HomeText» στη σκηνή. 
Βήμα 6ο: Τώρα θα δημιουργήσετε ένα κουμπί. Επιλέξτε το στιγμιότυπο του 
συμβόλου «HomeText» και μετατρέψτε το σε σύμβολο. Δώστε του όνομα 
«AnimatedButton» και επιλέξτε τη συμπεριφορά «Behavior: Button». 

 
Βήμα 7ο:  Κάντε διπλό κλικ πάνω στο στιγμιότυπο του συμβόλου «AnimatedButton» 
που έχετε στη σκηνή για να προσπελάσετε το πρωτότυπο σύμβολό του. Περιέχει ήδη 
ένα στιγμιότυπο του συμβόλου «HomeText» στο καρέ 1. 
Βήμα 8ο:  Τώρα θα τοποθετήσετε ένα στιγμιότυπο του συμβόλου «HomeAnimation» 
στην κατάσταση «Over» του κουμπιού. Κάντε κλικ στο καρέ «Over» της 
χρονογραμμής και εισάγετε ένα καρέ-κλειδί. Επιλέξτε το στιγμιότυπο και κάντε κλικ 
στο κουμπί «Swap» του πάνελ Properties. Θα εμφανισθεί το παράθυρο διαλόγου 
«Swap Symbol». 
Βήμα 9ο:  Στο παράθυρο διαλόγου «Swap Symbol» βλέπετε όλα τα σύμβολα που 
υπάρχουν στη βιβλιοθήκη. Μία κουκκίδα υπάρχει δίπλα στο σύμβολο, με το οποίο 
συνδέεται το τρέχον στιγμιότυπο.  

 
Κάντε κλικ στην καταχώριση του συμβόλου «HomeAnimation» και κατόπιν κάντε 
κλικ στο «OK». Τώρα θα παρατηρήσετε ότι το όνομα του τρέχοντος συμβόλου στο 
πάνελ «Properties» δίπλα στο «Instance of» έχει αλλάξει. 

 
 
Βήμα 10ο:  Στο καρέ Hit κάντε ένα κλικ και εισάγετε ένα καρέ-κλειδί και σχεδιάστε 
μία έλλειψη λίγο πιο μεγάλη από τη λέξη Home. Ύστερα διαγράψτε το στιγμιότυπο 
του συμβόλου HomeAnimation στο καρέ Hit. 
Βήμα 11ο: Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». 
 
Δημιουργήστε ένα κουμπί με κίνηση (animated button), το οποίο θα κινείται διαρκώς. 
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Δραστηριότητα 3: Εισαγωγή δεδομένων με το πληκτρολόγιο 

Υπάρχουν πεδία κειμένου τριών ειδών στατικό (static), δυναμικό (dynamic) και 
εισαγωγής (input). 
Σ’ αυτή τη δραστηριότητα θα φτιάξετε μια εφαρμογή που θα ζητάει από τον χρήστη 
να εισάγει δεδομένα (π.χ. το όνομά του). 
Βήμα 1ο: Σε ένα καινούργιο αρχείο  επιλέξτε το εργαλείο Κειμένου. Στο πάνελ 
«Properties» από την αναδιπλούμενη λίστα «Text Type» επιλέξτε «Input Text» και 
κάντε κλικ στο κουμπί «Εμφάνιση πλαισίου γύρω από το κείμενο» (Show Border 
Around Text). Κάντε κλικ στη σκηνή για να δημιουργήσετε μία ενότητα κειμένου. 
Βήμα 2ο: Με  επιλεγμένη την ενότητα κειμένου εισάγετε το «username» στο πεδίο 
«Var»: του πάνελ «Properties». 

 
Βήμα 3ο: Ανοίξτε το πάνελ «Actions», κάντε κλικ στο καρέ 1 της χρονογραμμής και 
εισάγετε ενέργεια «stop();».  
Βήμα 4ο: Δημιουργήστε ένα κουμπί και τοποθετήστε ένα  στιγμιότυπό του δίπλα στο 
πεδίο κειμένου στη σκηνή. Δώστε του όνομα «btnNext».  

 
Αυτό το κουμπί θα επιτρέπει στο χρήστη να προχωράει στο επόμενο καρέ. 
Πληκτρολογήστε τον παρακάτω κώδικα στο πάνελ «Actions» για το πρώτο καρέ της 
ταινίας: 

btnNext.onPress = function () { 

         nextFrame (); 

} 

 

Βήμα 5ο: Κάντε κλικ στο καρέ 2 της χρονογραμμής και εισάγετε ένα καρέ-κλειδί. 
Διαγράψτε ό,τι υπάρχει στη σκηνή σ’ αυτό το καρέ. Ύστερα κάντε κλικ στο καρέ 2 
και δημιουργήστε ακόμα ένα  πεδίο κειμένου. Στο πάνελ Properties από την 
αναδιπλούμενη λίστα Text Type επιλέξτε Dynamic Text και εισάγετε «message» ως 
όνομα του στιγμιότυπου (Instance Name). Εισάγετε 400 ως φάρδος του (δίπλα στο 
W:). 

 
Βήμα 6ο: Πληκτρολογήστε τον παρακάτω κώδικα στο πάνελ «Actions» για το 
δεύτερο καρέ της ταινίας: 

message.text = "Welcome "+username; 
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Αυτή η εντολή ορίζει την ιδιότητα «text» του στιγμιότυπου με το όνομα «message».  
Βήμα 7ο: Επιλέξτε «Control > Test Movie», μην ξεχάσετε να εισάγετε το όνομά σας, 
και πατήστε το κουμπί για να δείτε τι δημιουργήσατε. 
Δημιουργήστε στο ίδιο αρχείο και άλλο πεδίο κειμένου για να εισάγεται το επώνυμο 
του χρήστη. Θα εισάγετε το «user_last_name» στο αντίστοιχο πεδίο «Var». Για το 
δεύτερο καρέ της ταινίας θα εισάγετε τον παρακάτω κώδικα: 

message.text = "Welcome "+username+" "+ user_last_name; 
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Φύλλο εργασίας  

8. Ήχοι στο Flash  

 

Όνομα: 

Τάξη: 

Διάρκεια: 2 διδακτικές ώρες 

 

Διδακτικοί στόχοι: 

Με το συγκεκριμένο φύλλο εργασίας  θα μάθετε:  

 τους ηχητικούς τύπους  

 να εισάγετε ήχους  

 να χρησιμοποιείτε τους ήχους στα καρέ και να συγχρονίζετε τον ήχο με το 

animation 

 να χρησιμοποιείτε τους ήχους στα κουμπιά  

 

Δραστηριότητα 1: Ηχητικοί τύποι  και εισαγωγή ήχων 

Στο Flash μπορείτε να εισάγετε ήχους, αλλά δεν μπορείτε να τους δημιουργείτε. 

Το Flash μπορεί να εισάγει ψηφιακό ήχο αποθηκευμένο στις ακόλουθες μορφές: 

 wav (μόνο για τα Windows) 

 AIFF (μόνο για το Macintosh) 

 mp3 (και για τα Windows και για το Macintosh) 

Αν έχετε στον υπολογιστή σας εγκατεστημένο το QuickTime 4, τότε μπορείτε να 

εισάγετε ήχους και  στις ακόλουθες μορφές: 

 AIFF (και για τα Windows, και για το Macintosh) 

 Sound Designer II (μόνο για το Macintosh) 

 Sound Only QuickTime Movies (και για τα Windows, και για το Macintosh) 

 Sun AU (και για τα Windows, και για το Macintosh) 
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 System 7 Sounds (μόνο για το Macintosh) 

 wav (και για τα Windows, και για το Macintosh) 

 

Βήμα 1ο: Για να εντοπίσετε στον υπολογιστή σας αρχεία της μορφής «wav», επιλέξτε 

«Start > Search > All files and folders». 

Βήμα 2ο: Στο παράθυρο που θα ανοίξει, κάτω από το «All or part of the file name:» 

εισάγετε «*.wav». 

Βήμα 3ο: Θα παρατηρήσετε ότι υπάρχουν αρκετά αρχεία ήχου μορφής «.wav» στον 

φάκελο «C:\Windows\Media». 

Βήμα 4ο: Για να εισάγετε έναν ήχο σε ένα αρχείο Flash επιλέξτε «File > Import  > 

Import to Stage». Επιλέξτε ένα αρχείο ήχου μορφής «.wav» στον φάκελο 

«C:\Windows\Media».  Πατήστε το «Open».  

 

Ο ήχος θα εμφανισθεί στη Βιβλιοθήκη. 

Ελέγξτε αν υπάρχουν αρχεία μορφής «mp3» στον υπολογιστή σας. 
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Δραστηριότητα 2: Ήχοι στα καρέ  και συγχρονισμός ήχου με animation 

Για να χρησιμοποιήσετε τους ήχους στα καρέ ακολουθήστε τα εξής βήματα:  

Βήμα 1ο: Σε ένα καινούργιο αρχείο σχεδιάστε ένα ορθογώνιο στο πρώτο καρέ και 

μετατρέψτε το σε σύμβολο.  

Βήμα 2ο: Εισάγετε καρέ-κλειδιά στα καρέ 20 και 30.  

Βήμα 3ο: Κάντε κλικ στο καρέ 30, επιλέξτε το στιγμιότυπο του ορθογωνίου και 

μετακινήστε το στη σκηνή.  

Βήμα 4ο: Κάντε κλικ σε οποιοδήποτε καρέ ανάμεσα στο 20 και 30 στη χρονογραμμή.  

Βήμα 5ο: Στο πάνελ «Properties» από την αναδιπλούμενη λίστα «Tween» επιλέξτε 

«Motion».  

Βήμα 6ο: Εισάγετε το αρχείο ήχου «drums02.mp3», το οποίο σας δίνεται μαζί με το 

φύλλο εργασίας, όπως μάθατε στην προηγούμενη δραστηριότητα.  

Βήμα 7ο: Ανοίξτε το παράθυρο της Βιβλιοθήκης. Εκεί θα δείτε τον ήχο που μόλις 

έχετε εισάγει.  

Βήμα 8ο: Δημιουργείστε καινούργιο επίπεδο (layer) και ονομάστε το «Sound».  

 

Βήμα 9ο: Εισάγετε καρέ-κλειδιά στα καρέ 20 και 30 του επιπέδου «Sound».  

Βήμα 10ο: Κάντε κλικ στο καρέ 20 του επιπέδου «Sound». Για να προσαρτήσετε τον 

ήχο στο καρέ, μπορείτε να σύρετε τον ήχο από τη Βιβλιοθήκη στη σκηνή. Όμως, 

επειδή εδώ θα ασχοληθείτε με τις ρυθμίσεις συγχρονισμού,  προσαρτήστε τον ήχο 

στο καρέ με άλλο τρόπο: ανοίξτε το πάνελ «Properties» και από την αναδιπλούμενη 

λίστα «Sound» επιλέξτε τον ήχο. Γενικά, αυτή η λίστα περιέχει όλους τους ήχους που 

έχουν εισαχθεί στο αρχείο.  

 

Βήμα 11ο: Η ρύθμιση συγχρονισμού γίνεται από την αναδιπλούμενη λίστα «Sync:». 

«Event» είναι η προεπιλεγμένη ρύθμιση. Με αυτή τη ρύθμιση οι ήχοι αρχίζουν να 

αναπαράγονται, όταν η ταινία φτάνει στο συγκεκριμένο καρέ-κλειδί και συνεχίζουν 

να αναπαράγονται μέχρι να ολοκληρωθούν. Αφήστε αυτή τη ρύθμιση επιλεγμένη.  
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Βήμα 12ο: Για να σταματήσετε τον ήχο στο τέλος του animation κάντε κλικ στο καρέ 

30 του επιπέδου «Sound».  

Βήμα 13ο: Από την αναδιπλούμενη λίστα «Sound» επιλέξτε τον ήχο «drums02.mp3».  

Βήμα 14ο: Από την αναδιπλούμενη λίστα «Sync:» επιλέξτε «Stop». 

 

Βήμα 15ο: Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». Ο ήχος 

αρχίζει ταυτόχρονα με την αρχή του animation και σταματάει στο τέλος του. 

Με ποιους τρόπους μπορείτε να εισάγετε έναν ήχο σε ένα καρέ; 

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Δραστηριότητα 3: Ήχοι στα κουμπιά    

Οι ήχοι μπορούν να προσαρτηθούν σε διαφορετικές καταστάσεις ενός κουμπιού. 

Επειδή θα αποθηκεύονται μαζί με το σύμβολο του κουμπιού, θα λειτουργούν για όλα 

τα στιγμιότυπα του κουμπιού.   

Για να προσθέσετε ήχο στην κατάσταση «Down» του κουμπιού, ο οποίος θα 

ακούγεται όταν θα κάνετε κλικ πάνω στο κουμπί, ακολουθήστε τα εξής βήματα: 

Βήμα 1ο: Σε ένα καινούργιο αρχείο Flash δημιουργείστε ένα κουμπί. Γι αυτή τη 

δραστηριότητα δεν  είναι απαραίτητο να ορίσετε την εμφάνιση του κουμπιού για τις 

καταστάσεις «Over», «Down» και «Hit».  

Βήμα 2ο: Κάντε διπλό κλικ  στο στιγμιότυπο του κουμπιού για να προσπελάσετε το 

πρωτότυπο σύμβολο του κουμπιού, δηλαδή αυτό που βρίσκεται στη βιβλιοθήκη.  

Βήμα 3ο: Στη χρονογραμμή του κουμπιού δημιουργήστε καινούργιο επίπεδο (layer) 

και ονομάστε το «Sound». 
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Βήμα 4ο: Στο επίπεδο «Sound» εισάγετε ένα καρέ-κλειδί στο καρέ, το οποίο 

αντιστοιχεί στην κατάσταση «Down». 

 

Βήμα 5ο: Επιλέξτε αυτό το καρέ στη χρονογραμμή. Στο πάνελ «Properties» από την 

αναδιπλούμενη λίστα «Sound» επιλέξτε τον ήχο.  

 

Βήμα 6ο: Επιλέξτε «Event» από την αναδιπλούμενη λίστα «Sync».  

Βήμα 7ο: Δημιουργήστε το κλειδί-καρέ για το καρέ Down.  

 

 

Βήμα 8ο: Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». Κάνοντας 

κλικ πάνω στο κουμπί, θα ακούσετε τον ήχο. 

Εισάγετε και άλλον ήχο στη βιβλιοθήκη και προσαρτήστε τον στην κατάσταση 

«Over» του κουμπιού. Θα ακούγεται όταν ο δείκτης του ποντικιού είναι πάνω από το 

κουμπί. 
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Φύλλο εργασίας  

9. Εργασία με βίντεο στο Flash  

 

Όνομα: 

Τάξη: 

Διάρκεια: 2 διδακτικές ώρες 

 

 

Διδακτικοί στόχοι: 

Με το συγκεκριμένο φύλλο εργασίας  θα μάθετε:  

 να εισάγετε και να εξάγετε βίντεο στο Flash 

 να προσομοιώνετε βίντεο στο Flash   

 

 

Δραστηριότητα 1: Εισαγωγή και εξαγωγή βίντεο στο Flash 

Υπάρχουν διάφοροι τύποι αρχείων βίντεο, οι οποίοι μπορούν να εισάγονται σε ένα 

αρχείο Flash με σκοπό να παρουσιάζονται online.  

Το Flash έχει πλεονεκτήματα για την παρουσίαση βίντεο online: 

 Το Flash Player είναι πολύ διαδεδομένο. 

 Το Flash βίντεο ενσωματώνεται πολύ καλά στις ιστοσελίδες και μπορεί να 

εξασφαλίσει έλεγχο της αναπαραγωγής του. 

 Ένα βίντεο ελέγχεται μέσα στο αρχείο «swf», όπως κάθε άλλο αντικείμενο 

πολυμέσων, ως ένα μέρος του περιεχομένου του. 

Η εισαγωγή βίντεο στο Flash γίνεται με τρόπο, παρόμοιο με την εισαγωγή ήχου: με 

επιλογή «File > Import  > Import  Video» και ύστερα επιλογή ενός αρχείου βίντεο. 

Υπάρχουν διαφορετικές επιλογές διανομής (Deployment) κατά την εισαγωγή ενός 

βίντεο στο Flash: να γίνει «Embedded», «Progressive» ή «Streaming». Κατά τις 

επιλογές «Progressive» και «Streaming» το βίντεο βρίσκεται έξω από το αρχείο 

«swf» του Flash και δεν αυξάνει το μέγεθος του αρχείου «swf». Κατά την επιλογή 

«Embedded» το βίντεο ενσωματώνεται στη χρονογραμμή του αρχείου «fla». Επειδή 
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αυτό αυξάνει το μέγεθος του αρχείου «swf», η επίλογή «Embedded» είναι  

κατάλληλη μόνο για ένα πολύ μικρό βίντεο – έως 5 δευτερόλεπτα. 

Σ’ αυτή τη δραστηριότητα θα εισάγετε ένα βίντεο με την επιλογή «Embedded». Για 

να το κάνετε, ακολουθήστε τα εξής βήματα: 

Βήμα 1ο: Σε ένα καινούργιο αρχείο επιλέξτε «File > Import  > Import  Video».  

Εντοπίστε (browse) το αρχείο βίντεο «clock.avi», το οποίο σας δίνεται μαζί με το 

φύλλο εργασίας. Πατήστε το «Open» και ύστερα το «Next». 

Βήμα 2ο: Επιλέξτε το «Embed video in SWF and play in timeline» και πατήστε το  

«Next». 

Βήμα 3ο: Αφήστε τις προεπιλεγμένες επιλογές:  

 

και πατήστε το  «Next». Θα σας ζητηθούν ρυθμίσεις για τη συμπίεση κτλ. Πάλι 

αφήστε τις όπως είναι και πατήστε το  «Next» και ύστερα το «Finish». 

Βήμα 4ο: Ένα στιγμιότυπο του βίντεο θα είναι στη σκηνή (stage). Με το εργαλείο 

«Free Transform Tool» μικραίνετέ το λίγο.  

Βήμα 5ο: Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». 

Βήμα 6ο: Τώρα θα εξάγετε το βίντεο, το οποίο μόλις έχετε εισάγει, ως Flash βίντεο 

σε μορφή «flv». Κάντε δεξί κλικ πάνω στο όνομα του βίντεο στη Βιβλιοθήκη και 

επιλέξτε «Properties». 

Βήμα 7ο: Πατήστε το κουμπί «Export» στο παράθυρο διαλόγου «Video Properties». 

Αποθηκεύστε το αρχείο σας με το όνομα «my_video.flv» στο «Desktop». Πατήστε το 

«OK». Όπως βλέπετε, δεν σας ζητήθηκε καμιά ρύθμιση κατά την εξαγωγή. 
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Βήμα 8ο: Τώρα θα εισάγετε αυτό το Flash βίντεο στο αρχείο σας, το οποίο το έχετε 

ανοικτό. Επιλέξτε «File > Import  > Import  Video».  Εντοπίστε (browse) το αρχείο 

βίντεο «my_video.flv», που μόλις αποθηκεύσατε. Πατήστε το «Open» και ύστερα το 

«Next». Κάντε τις επιλογές όπως στα προηγούμενα βήματα. Θα δείτε ότι αυτή τη 

φορά δεν σας ζητήθηκαν ρυθμίσεις για τη συμπίεση, επειδή το αρχείο είναι ήδη 

συμπιεσμένο με τις ρυθμίσεις, οι οποίες ορίστηκαν κατά την εξαγωγή του.  

Τα αρχεία «flv», τα οποία δημιουργούνται με τη διαδικασία εξαγωγής από το Flash, 

μπορούν να εισάγονται μετά στα τελικά αρχεία ταινιών. Μπορούν να συνδυάζονται 

με άλλα στοιχεία, όπως αναφέρθηκε πιο πάνω. 

Τι θα μπορούσατε να επιλέξετε αντί για το «Embed video ...» για ένα βίντεο μεγάλης 

διάρκειας; 

..........................................................................................................................................

..........................................................................................................................................

.......................................................................................................................................... 

 

Δραστηριότητα 2: Προσομοίωση βίντεο στο Flash  

Είναι καλό να έχει ο χρήσης τον έλεγχο κατά την αναπαραγωγή ενός βίντεο – να  έχει 

στη διάθεσή του τα κουμπιά «Stop», «Play», «Resume» και «Control Volume». 

Στο Flash υπάρχει flash component FLVPlayback, το οποίο επιτρέπει τέτοιον έλεγχο 

του βίντεο. Σ’ αυτή τη δραστηριότητα θα χρησιμοποιήσετε αυτό το flash component 

και θα ορίσετε τις ιδιότητές του. 

Ακολουθήστε τα εξής βήματα: 

Βήμα 1ο: Σε ένα καινούργιο αρχείο επιλέξτε «File > Import  > Import  Video».  

Εντοπίστε (browse) το αρχείο βίντεο «my_video.flv», το οποίο δημιουργήσατε και 

αποθηκεύσατε στην προηγούμενη δραστηριότητα. Πατήστε το «Open» και ύστερα το 

«Next».  

Βήμα 2ο: Επιλέξτε «Progressive download from a web server»  και πατήστε το 

«Next». 
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Βήμα 3ο: Εμφανίζονται επιλογές για το flash component FLVPlayback. Από την 

αναδιπλούμενη λίστα «Skin» επιλέξτε «SteelExternalNoVol.swf».  

 

Πατήστε το «Next» και ύστερα το «Finish». Στη σκηνή (Stage) εμφανίζεται η 

περιοχή του βίντεο και τα κουμπιά ελέγχου. Με το εργαλείο «Free Transform Tool» 

ρυθμίστε το μέγεθός του. 
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Βήμα 4ο: Για να δείτε τι δημιουργήσατε, επιλέξτε «Control > Test Movie». Πατήστε 

όλα τα κουμπιά ελέγχου για να δείτε πώς λειτουργούν. 

Επαναλάβετε τα βήματα της παρούσας δραστηριότητας, επιλέγοντας στο Βήμα 2ο 

«Stream from Flash Media Server» αντί για το «Progressive download from a web 

server» . Στο Βήμα 3ο  επιλέξτε άλλο «Skin» από την αναδιπλούμενη λίστα. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 


